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Hinweise zu diesem Handbuch 

Mit diesem Handbuch erhalten Sie Hinweise und Informationen über die Funktion und Konfigura-
tion des LSS MasterGate.  

 

Dieses Handbuch gilt für das LSS MasterGate. Wie alle anderen Produkte aus dem Hause LSS 
GmbH unterliegt das LSS MasterGate einer ständigen technischen Weiterentwicklung. Deshalb 
werden hier unter Umständen Funktionen und Einstellungen beschrieben, die für das von Ihnen 
genutzte LSS MasterGate nicht verfügbar sind. 

Dieses Handbuch nutzt folgende Symbole, um für Sie wichtige Hinweise zu Ihrer Sicherheit und zur 
Konfiguration kenntlich zu machen. 

 

 
Hier erhalten Sie zusätzliche Informationen 

  

 

Achtung weist Sie auf Situationen hin, in denen Entscheidungen zu technischen 
Problemen mit dem Gerät oder zu Datenverlusten führen können. 

  

 

Eine Warnung bezeichnet Situationen, in denen Verletzungen oder Schäden für Leib 
und Leben auftreten können. 

 

 

Sicherheitshinweise 

Der Umgang mit dem LSS MasterGate ist nicht gefährlich. Schutzisolierung und weitere Sicher-
heitsmaßnahmen verhindern zuverlässig, dass Sie mit gesundheitsschädlichen Spannungen und 
Strömen in Berührung kommen. Beachten Sie aber folgende Hinweise: 

 

 

• Nehmen Sie niemals sichtbar beschädigte Geräte in Betrieb! 

• Liegt der Verdacht auf einen Defekt vor, trennen Sie das Gerät sofort von der 
Stromversorgung! Sichern Sie das Gerät gegen Wiederinbetriebnahme! 

• Öffnen Sie niemals das Gerät! Wenn Sie das Gerät öffnen besteht Lebensge-
fahr!  

• Berühren Sie niemals eine der intern verbauten Komponenten!  

• Reparaturen dürfen nur von Mitarbeitern der LSS GmbH durchgeführt werden. 
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Hinweise zur Handhabung 

Das LSS MasterGate ist für einen Dauerbetrieb konzipiert. Dennoch sollten Sie folgendes beachten: 

 

 

• Setzen Sie das Gerät nur zu seinem bestimmungsgemäßen Zweck ein! 

• Vermeiden Sie extreme mechanische Belastungen! 

• Vermeiden Sie jegliche mechanische Einwirkungen auf das Display! 

• Vermeiden Sie direkte Nässeeinwirkung sowie übermäßige Hitzeeinwirkung 
auf das Gerät! 

• Montieren Sie das Gerät nicht unmittelbar über Scheinwerfern! 

 

Wir freuen uns über Ihre Hinweise und Kommentare zu diesem Handbuch. Bitte senden Sie diese 
per E-Mail an mail@lss-lighting.de. 

 
 
 

History 

 

Datum Firmware Änderung 

10/2018 1.02 Erstauslieferung 

06/2020 1.02 Anpassung neues CD 

02/2024 2.06 Überarbeitung 
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Das MasterGate 
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Leistungsumfang 

Das LSS MasterGate ist ein Gateway, Konverter und Speicher für Daten in Theater-, Studio- und 
Veranstaltungsnetzwerken. Innerhalb eines Datennetzwerkes ist es die Verbindung zwischen 
Ethernet, DMX und Profibus-DP. Das MasterGate kann Daten aus, in und innerhalb dieser Netz-
werke routen, mergen, oder wandeln. Es kann dabei nicht nur die üblichen Protokolle eines 
Lichtnetzwerkes verarbeiten, sondern auch die des Nexus-Systems von Salzbrenner Stagetec®.  

 

Für eine umfassende Gerätekonfiguration und -überwachung unterstützt das LSS MasterGate das 
Remote Device Management (RDM). Ebenfalls können die Datenströme innerhalb des Lichtnetz-
werkes auf Monitoren in Echtzeit überwacht werden. Zur Überwachung von Einzelereignissen sind 
Verify-Funktionen zuschaltbar.  

 

Im LSS MasterGate können bis zu 32 Lichtstimmungen in einem Registerspeicher abgelegt und 
auch wieder abgerufen werden. Für Lichtstimmungen sind individuelle Ein- und Ausblendzeiten 
einstellbar. Im Zusammenspiel mit einem Digitalen Nebenpult, einer SPS oder einer anderen An-
steuermöglichkeit können so Arbeitslichter, Blaulichter, Probenlichter und sogar Lichtstimmungen 
für Zuschauerbereiche in einer Nebenanlage eingestellt und abgerufen werden.  

 

 

Das LSS MasterGate ist mit 8 voneinander unabhängigen DMX-Anschlüssen ausgestattet, die so-
wohl als DMX-Eingänge als auch DMX-Ausgänge definiert werden können. Zwei Anschlüsse sind 
mit DMX-Thru und schaltbarer Anschlussterminierung ausgestattet. Zusätzlich verfügt es über 
Ethernet- und Profibus-DP-Anschluss sowie einem Anschluss für einen externen seriellen Bus, über 
den eine Fernbedienung des Registerspeichers möglich ist (in Vorbereitung). 
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Funktionsübersicht 

Überblick 

Anschlüsse 

Das LSS MasterGate arbeitet pufferorientiert. Es hat 8 Merge-Puffer 1...8, die fest den 8 DMX-
Ports 1...8 zugeordnet sind. 

 

Das Bild zeigt die logische innere Struktur des LSS MasterGate mit allen Eingangsquellen für den 
ersten der 8 Merge-Puffer: 
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Jeder reale DMX-Port kann auf OFF/DMX-IN/DMX-OUT eingestellt sein: 

• ist der Port OFF, so kann der zugehörige Merge-Puffer nicht verwendet werden 

• ist der Port ein DMX-OUT, so wird der Inhalt des Puffers direkt als DMX-Signal ausgegeben 

• ist der Port ein DMX-IN, so wird der zugehörige Merge-Puffer als "virtueller Out" ganz nor-
mal wie jeder DMX-OUT behandelt;  

der Port kann natürlich kein DMX-Signal ausgeben, aber der "virtuelle Out" kann z.B. über 
Netzwerk ausgesendet werden; 

das am DMX-IN hereinkommende DMX-Signal kann selbstverständlich in allen Routings 
verwendet werden 

 

 

DMX 

Anschlüsse 

Der LSS MasterGate verfügt über 8 frei als In oder Out definierbare DMX-Anschlüsse. In der XLR-
Version sind die Anschlüsse 1 bis 6 als Female und die Anschlüsse 7 und 8 als Male ausgeführt. An-
schluss 7 und 8 verfügen über eine zuschaltbare Terminierung und haben einen DMX-THRU zuge-
ordnet. 

 

Parameter für DMX-Out definierte Anschlüsse 

Sind die Anschlüsse als DMX-Ausgänge definiert, können für jeden Anschluss folgende Parameter 
eingestellt werden: 

 

• Timeout-Zeiten oder Halten des letzten 
Protokolls 

• Merge-Modus 

• Merge-Quellen 

• Patch (pro Kreis, pro Quelle) 

• Netzwerk-Sende-Universe mit Angabe der 
Priorität 

 

• DMX-Protokolllänge 

• DMX-Timing: 

Breaklänge 

 Mark After Break 

 Mark Before Break 

 Protokollrate 

 

 

Für DMX-Eingänge kann lediglich die Timeout-Zeit eingestellt werden. 
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Ethernet 

Licht-Netzwerkprotokolle 

Das LSS MasterGate unterstützt folgende Licht-Netzwerkprotokolle: 

 

• sACN 

• Art-Net 

• ShowNet 

• AVAB/UDP 

• AVAB/IPX 

 

Das Standard-Netzwerkprotokoll des LSS MasterGates bei Auslieferung ist sACN.  

Das LSS MasterGate kann bis zu 32 frei wählbare Universes über Netzwerk empfangen, von denen 
im Extremfall bis zu 15 verschiedene Universes pro Port gemergt werden können (Multi Universe 
Merge). 

Es werden ebenfalls Paket-Prioritäten sowie Prioritäten pro Kreis unterstützt, wenn dies das Licht-
Netzwerkprotokoll unterstützt (Kreisprioritäten nach sACN-Erweiterung ETC-DD). 

 

 

Netzwerk-Merge und Prioritäten 

Das LSS MasterGate kann immer bis zu 4 Netzwerk-Sender, die auf dem gleichen Universum (und 
Subnet, wenn vorhanden) senden, verarbeiten. Weitere werden ignoriert. 

Hierbei findet auch die Prioritätsverarbeitung (pro Paket oder pro Kreis) statt. Die Art der Priorität 
wird pro Quelle ausgewertet. Wird keine Priorität pro Kreis gesendet, so erfolgt der Rückfall auf 
die Paketpriorität. 

Priorität 0 wird immer gemergt. 

Für die weitere Verarbeitung mit LTP wird für jede Netzwerk-Quelle ein Timestamp mitgeführt. Die 
Auswahl des HTP/LTP-Modus ist später im Routing pro Ausgabekreis wählbar.  

 

 

Netzwerkeinstellungen 

Folgende Parameter sind einstellbar: 

 

• separate Einstellung von Licht-Sende- und Empfangsprotokoll 

• Verhalten bei Ausfall der letzten Empfangsquelle (Timeout, Hold) 

• Licht-Senderate (bei Leerlauf ohne Datenänderung) 

• IP-Adresse Manuell / verschiedene voreingestellte Subnets / DHCP / LinkLocal 

• IP-Subnetz-Maske 

• DNS-Server 

• Domainname 

• Multicast DNS 
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• Artnet 3 Netzwerkadresse 

• Art-Net 4 

• Netzwerkdienste wie Telnet und FTP 

• RDM-Net Netzwerkprotokoll nach ANSI 1.37 

• Art-Net RDM oder RDMnet 

• Einschaltung der Sende- und Empfangschecksummenprüfung 

• Einstellung der Ethernet-Geschwindigkeit und des Duplex-Mode 

 
 

Profibus 

Das LSS MasterGate besitzt eine flexible Parametrierung von Profibus-Dateien. Empfangene Profi-
bus-Daten können mit Daten aus anderen Quellen gemergt werden. Ebenso können Daten aus 
den 8 Merge-Puffern in Richtung Profibus gesendet werden.  

  

 

Stimmungsspeicher 

Das LSS MasterGate ist mit einem Speicher für bis zu 32 Lichtstimmungen (Register) ausgestattet, 
die über Profibus, DMX-In, Art-Net oder andere Ansteuerungen angesprochen und gesteuert wer-
den können. 

 

Der Lichtstimmungsspeicher kann flexibel zu einem oder allen Ports hinzugemergt werden. 

Global kann eingestellt werden, ob die Lichtstimmungen nur 1 oder alle 8 Universen enthalten. 
Dies ist die interne Registerlänge (Anmerkung: ein Universe ist hier immer 512 Werte, unabhängig 
davon, wie viele wirklich benutzt werden bzw. DMX- oder netzwerkseitig eingestellt sind). 

 

Wenn 1, so wird beim Einspeichern einer der 8 Mergepuffer ausgewählt und gespeichert. 

Ausgabeseitig kann dieses einzelne Universe im Lichtstimmungsspeicher wahlweise den 8 Merge-
puffern hinzugemergt werden. 

 

Wenn 8, so ist die Zuordnung fest, 1->1, 2->2, ...; es werden immer alle 8 Mergepuffer-Inhalte in 
den Stimmungsspeicher eingespeichert, ausgabeseitig kann lediglich das Hinzumergen ein- bzw. 
ausgeschaltet werden. 

 

Jedes Register hat ein eigenes virtuelles Poti, mit dem die Lichtwerte multipliziert werden. Außer-
dem wird über alle 32 Register eine Summe gebildet, die wiederum mit einem globalem Poti mul-
tipliziert wird. Dies erfordert eine nicht unerhebliche Rechenleistung, falls 8 Universen pro Regis-
ter gespeichert sind. 
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Remotekonfiguration 

Für alle LSS-Geräte wird die kostenlose Software ConfigStudio empfohlen, die alle Features des LSS 
MasterGate und anderer LSS-Geräte, aber auch Art-Net-Geräte anderer Hersteller unterstützt. Nur 
mit dieser Software ist es möglich, alle Geräte im Netzwerk aufzufinden und das LSS MasterGate 
komplett remote zu konfigurieren. 

 

Als Art-Net-kompatibles Gerät arbeitet der LSS MasterGate problemlos mit Art-Net-Softwaretools 
anderer Hersteller, wie z.B. dem Programm DMX-Workshop zusammen (Download unter www.ar-
tisticlicence.com). Selbstverständlich hat der LSS MasterGate wie alle anderen ArtNet-Geräte eine 
eigene OEM-ID (ab Workshop-Version 3.57 erkannt und unterstützt). Über dieses Tool ist auch 
eine eingeschränkte Remote-Konfiguration möglich. Beachten Sie, dass Art-Net hier nur eine Un-
termenge des LSS MasterGate konfigurieren kann.  

 

Auch bei anderen eingestellten Licht-Protokollen als Art-Net ist der LSS MasterGate 
mit ConfigStudio immer konfigurierbar, es wird lediglich vorausgesetzt, dass der PC im 
IP-Adressbereich das LSS MasterGate liegt. 

 

DMX-Filter 

Das LSS MasterGate verfügt über die Möglichkeit, in allen 8 Mergepuffern/Ports gezielt DMX-
Kreise auszublenden (auf 0 zu setzen). Dies geschieht nach dem Merge aller Quellen. Das Ausblen-
den wird auch in per Netzwerk ausgesendeten Mergepuffern wirksam. 

 

Hauptanwendung ist die zielgerichtete Abschaltung von vielen Kreisen gleichzeitig, z.B. von Profi-
bus oder LSS-Bus aus. So kann beispielsweise eine dynamische Trennung von Spielstätten erreicht 
werden, so dass das MasterGate nur bestimmte Kreise nachfolgender Geräte aussteuern darf. 
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Anzeige-, Anschluss- und Bedienele-
mente 
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Geräteüberblick 

Frontseite 

Menübildschirm 

 

Freidefinierbare  

DMX-Anschlüsse 

 
 

Betriebsanzeigen 

und Taster 

 

Ethernet 

Anschluss 

 

Dreh/Drück- 

Encoder 

 

DMX-Anschlüsse 

Der LSS MasterGate kann mit DMX-Anschlüssen im 5polig XLR oder RJ45-Design ausgestattet wer-
den. Die Anschlüsse sind in der Menüsteuerung als Ein- oder Ausgänge frei definierbar. Oberhalb 
der Anschlüsse wird der Betriebszustand mit LEDs angezeigt: 

 

LED Farbe Bedeutung 

Anschluss als 
DMX-In defi-
niert 

Gelb Ein: Datenempfang 

Flackern: RDM ist aktiv 

Blinkt: dauerhaft fehlerhaftes Protokoll 

Aus: keine Datenempfang 

Anschluss als 
DMX-Out de-
finiert 

Gelb Ein: Daten werden gesendet 

Flackern: Hold aktiv – kein Empfang von Daten, letzte empfangene 
Daten werden weiter gesendet 

Blinkt: RDM aktiv 

Aus: DMX-Out ist abgeschaltet 
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Ethernet Anschluss 

Oberhalb des Ethernet-Anschlusses wird der Betriebszustand mit LEDs angezeigt: 

 

LED Farbe Bedeutung 

Speed Grün Ein: Es besteht eine Datenverbindung mit 100MBit/s. 

Aus: In Verbindung mit Link-LED 

Link Gelb Ein:  Es besteht eine Datenverbindung. Ist die Speed-LED gleich-
zeitig aus, besteht eine Datenverbindung von 10MBit/s. 

Flackern: Daten werden übertragen. 

Aus: Sind Link- und Speed-LEDs aus, besteht keine Ethernet-
Verbindung. 

 

Betriebsanzeigen 

Über die LEDs an der Frontseite werden die Betriebszustände des LSS MasterGate angezeigt. 

 

LED Farbe Bedeutung 

Power blau Ein: Betriebsspannung vorhanden 

Aus: Betriebsspannung nicht vorhanden 

ACTIVE/FAIL  Grün Flackern: Es liegen aktive UND gerouteten Netzwerk -Universen an 
(egal ob Empfang oder Senden) 

Ein: DMX-Ports  

Blinkt: Gerät wird über ConfigStudio oder RDM identifiziert 

Aus: Alle DMX-Anschlüsse sind aus 

Orange Blinkt: Warnmeldung 
Gerätetemperatur ist höher als 65°C 

Rot Nur Fehlermeldungen 

Flackert: Nur beim Start – keine Fehlermeldung 

Blinkt: Gerätetemperatur ist höher als 70°C - Akustisches Warnsig-
nal ertönt 
Lüfter prüfen und Gerät ausschalten! 

An: Sammelfehler – Service informieren! 

 

Im Gerät sind noch weitere Diagnose-LEDs vorhanden. Diese sind für Service und Wartung vorge-
sehen. 

  



LSS MasterGate 

20 

  
 

 

 

Taster 

Auf der Frontseite des LSS MasterGate befindet sich ein Reset- Taster, mit dem das Gerät neu ge-
startet werden kann. 

 

Taste Rückmeldung Bedeutung 

Reset keine Neustart des LSS MasterGate 

 

 

Rückseite 

 
 

 Spannungs-
versorgung 

Gerätesi-
cherung 

 Profibus-DP Datenträger optionale 
DMX-Filter 

 

 

Spannungsversorgung und Gerätesicherung 

Die Spannungsversorgung erfolgt über Kaltgeräteanschluss (IEC 60320-C14) auf der Rückseite. 
Oberhalb des Anschlusses ist die Gerätesicherung.  

 

Sicherungstyp:  Schmelzsicherung 1,6A T 

 

Datenträger  

Auf dem Datenträger befinden sich das Betriebssystem und alle gespeicherten Daten. Er kann im 
Falle eines Gerätetausches aus dem Slot herausgenommen und in ein Ersatzgerät eingeschoben 
werden. 

 

 

Der Datenträger darf unter keinen Umständen aus dem Gerät entnommen werden, 
wenn es noch eingeschaltet ist! 
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Konfiguration des LSS MasterGate 
am Gerät 
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Hinweise zur Bedienung des Menüs 

Aufbau 

Die Menüstruktur des LSS MasterGate ist hierarchisch angeordnet. Die erste Ebene entspricht den 
unterschiedlichen Betriebsanzeigen, die durch Drehen des Encoderrades ausgewählt werden kön-
nen. Von den Betriebsanzeigen kommt man durch Drücken des Encoderrades in das Hauptmenü. 
Vom Hauptmenü sind die weiteren Untermenüs thematisch in Ebenen unterteilt. 

 

Menüauswahl 

Drehen am Encoder wählt die unterschiedlichen Menüpunkte und Schaltflächen. Das markierte 
Menü oder die Schaltfläche wird  invers  dargestellt. Kurzes Drücken auf den Encoder markiert die-
sen Menüpunkt oder die Schaltfläche als ausgewählt. 

 

Einstellungen vornehmen und speichern 

Der ausgewählte Parameter wird  invers blinkend  dargestellt und kann nun durch Drehen am En-
coder verändert werden. Erneutes Drücken übernimmt die Einstellung, die veränderten Parameter 
werden dann sofort wirksam. 

 

Das Betätigen der Schaltfläche „Cancel“ führt das LSS MasterGate in das vorhergehende Menü zu-
rück, geänderte Werte werden nicht gespeichert, auch wenn sie bereits temporär eingestellt wa-
ren. 

 

Das Betätigen der Schaltfläche „Ok“ speichert die geänderten Werte dauerhaft.  

 

Wenn der Encoder längere Zeit nicht betätigt wird, geht das LSS MasterGate automatisch in die 
Betriebsanzeige zurück. Dabei wird das Gerät wieder gegen unbefugte Bedienung verriegelt und 
das eingegebene Passwort gelöscht. Nicht gespeicherte Änderungen im aktuellen Menü gehen 
verloren. Der Timeout kann im Bildschirmschoner-Menü eingestellt werden (Default 30s). 

Dieser Timeout ist in den Monitor-Modi unwirksam, damit auch längere Beobachtungen möglich 
sind. 

 

 

Bitte beachten Sie, dass jede Änderung der Einstellungen weitreichende Folgen auf 
Ihre Lichtanlage haben kann. Die folgend beschriebenen Einstellungsmöglichkeiten 
setzen auch voraus, dass Sie Erfahrungen und Kenntnisse in der Konfiguration von 
DMX und von Ethernet-Lichtprotokollen besitzen.  
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Informationsbildschirm und Betriebsanzeigen 

Der Informationsbildschirm (s.Abb.) ist der Hauptbildschirm des Gerätes. Er zeigt die MasterGate-
Version, Bezeichnungen sowie IP- und MAC-Adresse an. Ausgehend von diesem Bildschirm kann 
man durch Drehen des Encoderrades insgesamt 5 Betriebsanzeigen auswählen: Routing, DMX, 
NW-In, NW-Out und Profibus. 

 

 
 

Neben Zahlenwerten wie z.B. Universe-Nummern zeigen sie Striche für nicht konfigurierte Werte 
oder Kreise an. Ein ausgefüllter Kreis bedeutet „Zustand aktiv“, ein nicht ausgefüllter Kreis bedeu-
tet „Zustand nicht aktiv“, blinkend bedeutet „Fehler“. 

 

 

Routing-Anzeige 

In der Routing-Anzeige wird ein allgemeiner Überblick über die Konfiguration an den einzelnen 
Ports dargestellt. Von links nach rechts sind Portkonfiguration IN/OUT, Mergeverhalten und Uni-
verses dargestellt. 

 

DMX-Anzeige 

In der DMX-Anzeige können die Protokoll-Parameter der aktiven Ports abgelesen werden. 

 

NW-In- und NW-Out-Anzeige 

Diese beiden Bildschirme zeigen die Informationen über TX- und RX-Universes. Die In-Anzeige ver-
fügt über 32 Positionen, die den möglichen 32 In-Universes entsprechen. Es werden Universe-
Nummern und gegebenenfalls Prioritäten dargestellt. Ähnlich verhält es sich mit der Out-Anzeige. 
Angezeigt wird das Sende-Universe mit seiner Priorität 

 

Profibus-Anzeige 

Die fünfte der Betriebsanzeigen stellt die Profibus-Parameter, insbesondere Bus-Status, Baudrate 
und DP-Adresse dar. 
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Pin-Eingabe 

Vor dem Einstieg ins Hauptmenü muss, falls eingestellt, eine Pinnummer eingegeben werden. 

 

 
 

 

Dabei „merkt“ sich das LSS MasterGate die zuletzt eingegebene Pin so lange, bis sie entweder mit 
der Schaltfläche „Clear“ rückgesetzt wird oder im Security-Menü mit der Schaltfläche „Clear“ ganz 
abgeschaltet wird. 

 

 

Auswahl Bedeutung 

***** Eingabe der Ziffern der Pin durch Drücken, Drehen und wieder Drücken 

Clear Eingegebene Pin löschen 

Ok Die Pin wird überprüft. Bei korrekter Eingabe Aufruf des Hauptmenüs, sonst zu-
rück in die Betriebsanzeige 

 

 

Menüstruktur 

Im Folgenden wird die Menüstruktur des MasterGate beschrieben. 

Im Grundzustand zeigt das Gerät den Informationsbildschirm oder eine der 5 Betriebsanzeigen. In 
das Gerätemenü kommt man von dort aus immer durch Drücken des Encoderrades. Die Menüst-
ruktur ist hierarchisch aufgebaut und umfasst Submenüs zur Information, Funktionseinstellungen 
und allgemeinen Geräteeinstellungen.  
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Monitoring mit dem View-Menü 

Aufbau des View-Menüs 

 

Mit den Anzeigen im View-Menü erhalten Sie einen Überblick über aktuellen Einstellungen, Daten-
transfer und Mergesituation des LSS MasterGate. Die Anzeigen sind alle in Echtzeit. Die Anzeigen 
im View-Menü verstehen sich als Monitoring. Dadurch lassen sie sich problemlos als Überwa-
chungs- und Diagnosetools einsetzen. 

 

Ebene 1 Ebene 2 Ebene 3 Ebene 4 
 

View DMX DMX-In 
1…8 

Mode, Verify, Range Darstellung DMX-Eingangswerte (grafisch, prozentual, he-
xadezimal), Verify-Funktion 

DMX-
Out 1…8 

Mode, Verify, Range Darstellung DMX-Ausgangswerte (grafisch, prozentual, he-
xadezimal), Verify-Funktion 

RDM In 1…8 Für kommende Anwendungen 

Out 1…8 Für kommende Anwendungen 

Ether-
net 

In-Uni-
verse 
1…8 

Merge 1…4 Anzeige Empfangsprotokoll, Mergequellen, Darstellung 
DMX-Eingangswerte (grafisch, prozentual, hexadezimal), 
Verify-Funktion 

Out-Uni-
verse 
1…8 

Mode, Verify, Range Anzeige Ausgangsprotokoll, Darstellung DMX-
Ausgangswerte (grafisch, prozentual, hexadezimal), Verify-
Funktion 

 

 

Die DMX-Monitore  

 

 
 

Das Menü View→DMX gibt einen Überblick über die Aktivitäten an den DMX- Anschlüssen. Im Un-
termenü für alle Anschlüsse können die Signale für jedes Bit hexadezimal oder prozentual darge-
stellt werden.  

 

Alle Monitoring-Anzeigen können mit VERIFY arbeiten und sind somit ein universelles Hilfsmittel 
auch für einmalige Ereignisse („Flickerfinder“). 
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View→DMX→DMX-Monitor 

Im DMX-Monitor wird auf der Übersichtsseite zunächst der Zustand der Schnittstellen angezeigt:  

 

Symbol Bedeutung 

-- Nicht als DMX-In oder Out definiert 

Leerer Kreis Als DMX-In oder Out definiert, kein Datentransfer 

Gefüllter Kreis Als DMX-In oder Out definiert, Datentransfer läuft 

H Als DMX-Out definiert, Port im HOLD-Zustand 

 
 

View→DMX→DMX-Monitor→Port n 

Eine ausgefüllte LED bedeutet „Schnittstelle/Puffer aktiv“, leer bedeutet „nicht aktiv“. Die LEDs 
können direkt angewählt werden und mit Drücken des Encoders gelangt man so in die Monitor-
Anzeige der einzelnen Anschlüsse: 

 

Im DMX-Monitor können alle Kreise des angewählten 
DMX-In oder DMX-Out in ihrem Wert grafisch als Bal-
kenanzeige oder als Prozentwert und Hexadezimalzahl 
dargestellt werden. Die Umschaltung geschieht mit 
„Mode“. 

 

In der Titelzeile werden verschiedene Messwerte angezeigt: 

 

Symbol Bedeutung 

On/Error/not used Zustand des In oder Out 

Len Channel-Anzahl des DMX-In-ProtokollsOut in ms 

Tmo Timeoutzeit des DMX-Out 

SC Startcode des DMX-In-Protokolls 

 

Unterhalb der Anzeigen können folgende Einstellungen vorgenommen werden. 
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Einstellung Bedeutung 

Page Auswahl der Anzeigeseiten. Zur besseren Übersicht für zusammenhängende Kreise 
blättert das LSS MasterGate in allen Monitoring-Anzeigen immer nur um 2 Zeilen. 

Mode Schaltet zwischen grafischer und Zahlenanzeige um. 

Verify Schaltet den Verify-Modus ein (Flickerfinder) 

Anzeige V rechts oben im Display). 

Range Aufruf des Menüs zur Einschränkung des Verify-Bereiches. 

OK Eine Menüebene zurück. 

 

 

In diesem Monitor ist die selbsttätige Rückkehr in die Betriebsanzeige außer Kraft 
gesetzt, um auch längere Beobachtungen zu ermöglichen. 

 

Kreise bei DMX-OUT Ports, bei denen das DMX-Filter aktiv ist, werden in der oberen Zeile durch 
"fi" dargestellt. 

 
 

Verify-Modus 

Mit dem Einschalten des Verify-Modus mit „Verify“ (rechts oben wird nun ein V angezeigt) wird 
exakt der aktuelle Zustand eingespeichert und nun laufend mit den aktuellen Daten verglichen. Bei 
einer auch nur kurzzeitigen Abweichung der Daten (es genügt ein Bit) wird der Verify abgebrochen 
(rechts oben ein nicht-inverses V). Das Ergebnis wird dargestellt, indem die abweichenden Werte 
farblich unterlegt sind. Mit einem lauten Signalton macht das LSS MasterGate auf den Verify-Feh-
ler aufmerksam. Erneutes Drücken auf „Verify“ schaltet den Verify-Modus ab (rechts oben kein V). 

 

Man kann damit über lange Messzeiten Protokollstörungen, -verschiebungen und Flackern durch 
defekte Geräte diagnostizieren, ohne einen speziellen DMX-Tester mit Flickerfixer zu benötigen.  

 

Mit dem „Range“-Menü kann der Bereich für Verify bis zu einem Stromkreis eingegrenzt werden.  
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Die Ethernet-Monitore 

View→Ethernet 

 

 
 

Auf der Übersichtsseite kann der gesamte Zustand des empfangenen Lichts überblickt werden. 
Eine ausgefüllte LED bedeutet "Quelle aktiv", leer bedeutet "nicht aktiv". 

 

Untereinander sind in 11 Zeilen 11 der 32 Empfangspuffer dargestellt. Mit den Pfeilsymbolen "<<" 
und ">>" kann man weitere Seiten aufrufen. 

Neben der Universe-Nummer verdeutlichen je vier Punkte die möglichen vier Sender, die auf dem 
gleichen Universe (und ggf. Subnet) empfangen und gemergt werden können.  

Neben jedem Sender ist dessen Paketpriorität zu sehen, falls vom Protokoll unterstützt. Ganz 
rechts steht die aktive Summenpriorität dieses Universes, falls alle Quellen nur Paketprioritäten 
senden (bzw. die Kreisprioritätsauswertung abgeschaltet ist). Ansonsten steht dort "Cha" als Kenn-
zeichen für ausgewertete Kreisprioritäten. 

Der letzte Buchstabe gibt an, ob auf diesem Universe LTP verwendet wird, "L" ansonsten "H" für 
HTP. 

 

 

Die Empfangspuffer zeigen den Empfang aus den eingestellten Subnets und Univer-
ses auch dann an, wenn das Ethernet als Quelle im Routing ausgeschaltet ist (und 
somit das LSS MasterGate selbst diese Universes nicht verwendet)! 

 

Die LEDs im Netzwerkmonitor können direkt ange-
wählt werden und mit Drücken des Encoders gelangt 
man so in die Monitor-Anzeige, die in Bedienung und 
Darstellung exakt der des DMX-Monitors entspricht. 
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In der Titelzeile werden verschiedene Messwerte angezeigt: 

 

Symbol Bedeutung 

Univ x/y: x= Universe-Nummer, y=Empfangspuffer 1...4 

Name, IP- oder MAC-Adresse sACN-Name oder Kennzeichnung der Quelle oder "not used" 

Pri Paketpriorität dieser Quelle 

/|\- Anzeige der eingehenden Pakete dieser Quelle 

 

 

View→Ethernet→Net Out 

Mit „Net Out“ gelangt man vom Netzwerk-Monitor in die Übersichtsseite der vom LSS MasterGate 
über Netzwerk ausgesendeten Universes. Untereinander sind in 8 Zeilen diese Puffer dargestellt. 

Universe (und ggf. Subnet) entsprechen den im Routing→Port→Net Out eingestellten Werten. 

Eine ausgefüllte LED bedeutet hier „Netzwerk-Senden aktiv“, leer bedeutet „nicht aktiv“.  

 

Die LEDs im Netzwerk-Sendemonitor können direkt angewählt werden und mit Drücken des En-
coders gelangt man so in die Monitor-Anzeige, die in Bedienung und Darstellung exakt der des 
DMX-Monitors entspricht. 

 
In der Titelzeile werden angezeigt: 
 

Symbol Bedeutung 

In/Out In: es wird der zugehörige DMX-IN direkt ausgesendet 

Out: es wird der Mergepuffer ausgesendet 

Nr Portnummer 

Len gesendete Universe-Länge 

Pri gesendete Paketpriorität 
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Funktionseinstellungen im Config-Menü 

 

 

Bitte beachten Sie, dass jede Änderung der Einstellungen weitreichende Folgen auf 
Ihre Lichtanlage haben kann. Die folgend beschriebenen Einstellungsmöglichkeiten 
setzen auch voraus, dass Sie Erfahrungen und Kenntnisse in der DMX- Konfiguration 
besitzen. 

 
 
 

Einstellen der DMX-Anschlüsse – PortSetup 

 

 
 
 
Im Menü PortSetup werden die DMX-Anschlüsse als Ein- oder Ausgänge definiert.  
Jeder DMX-Eingang ist gleichzeitig auch virtueller Ausgang. 

 

 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

Port 
Setup 

Port 1…8 N/A, DMX-IN, DMX-
OUT 
1..6 OUT, 7/8 IN 

Einstellen der DMX-Ports als IN, OUT oder Aus 

Termination Port 7/8 Off, On Einschalten der Terminierung für Port 7/8 

 
 

Symbol Bedeutung 

N/A DMX-Anschluss ist abgeschaltet 

DMX-In DMX-Anschluss ist als DMX-Eingang definiert 

DMX-Out DMX-Anschluss ist als DMX-Ausgang definiert 
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Terminieren der DMX-Anschlüsse 7 und 8 

Die Ports 7 und 8 besitzen jeweils einen schaltbaren DMX-Terminator. DMX-Signale müssen zwi-
schen dem ersten und letzten Gerät terminiert werden, um Störsignale zu vermeiden. Geräte in-
nerhalb einer DMX-Linie dürfen aber keinen Terminator aktiviert haben.  

 

Symbol Bedeutung 

Off Terminator ist abgeschaltet. 

On Terminator ist eingeschaltet. 

 
 
 

Konvertieren und Mergen von Daten – Routing 

Einleitung 

 

 
 

 

Zum Konvertieren und Mergen von Daten stehen 8 Mergepuffer zur Verfügung, die fest den DMX-
Ports zugeordnet sind (wie bereits in der Grafik unter Funktionsübersicht veranschaulicht). 

Die im Bild mit (*) gekennzeichneten Ports sind DMX-IN und somit als "virtuelle Outs" markiert. Sie 
verhalten sich genau wie die "richtigen OUTs", nur dass das Ergebnis nicht als DMX ausgesendet 
wird. Es kann aber z.B. ins Netzwerk gesendet oder von der SPS über Profibus verwendet werden. 

 

 

 

Auch beim Konvertieren von Ethernet-Protokoll zu Ethernet-Protokoll muss der Weg 
über die Mergepuffer gewählt werden! 
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Ebene 2 Ebene 3 Ebene 4 Einstellmöglichkei-

ten 
Bedeutung 

Routing Network Re-
ceive Univer-
ses 

Universe 1-32  32x 
Off oder Universe-
Nr. 

Eingabe von bis zu 32 Empfangs-Universes, die 
für das gesamte Gerät verwendet werden kön-
nen.   

Edit Merge 
for 

Port 1…8 Empfangs-Uni-
verse(s),  
DMX-IN 1…8 
Profibus 
Stimmungsspeicher 
Patch 
LTP 
Netzwerk-Senden 

Einstellen des Merge für die Mergepuffer/Ports. 
 
Gemergt werden können: bis zu 15 Empfangs-
Universes, alle konfigurierten DMX-IN, Profibus 
und Stimmungsspeicher. Je Port Einstellungen 
für den Patch, für LTP und eines Sende-Universe 
(unter Net Out). 

Options Multi Merge Off, On Schaltet das Multi Universe Merging global ein.  
 

 

Einstellen der Universes Routing->Network Receive Universes 

Auf der Seite "Network Receive Universes" hinterlegen Sie bis zu empfangene 32 Universes. 

Gehen Sie sparsam damit um, denn jedes kostet Rechenzeit. 

Die Universe-Nummern sind netzwerkprotokollabhängig (siehe Anhang). Protokolle mit einstellba-
rem Subnet ermöglichen die getrennte Eingabe von Subnet und Universe. 

Die Universe-Tabelle kann mit 3 Schaltflächen "Sort", "1:1" und "Clear" sortiert, 1:1 vorbelegt und 
komplett gelöscht werden.  

 

VORSICHT! Löschungen/Änderungen wirken sich sofort auf den Merge jedes Ports aus, wo diese 
Universes verwendet werden! 

 

 

Einstellen des Merge Routing->Ports 

Auf den Seiten "Port 1...8" mergen Sie alle gewünschten Empfangsdaten für diesen Mergepuf-
fer/Port zusammen, also 

• Universes (Auswahl im oberen Teil) 

• DMX-INs (LED-Punkt setzen/löschen) 

• Profibus (ON/OFF) 

• Stimmungsspeicher (ON/OFF) 

Außerdem geben Sie hier manuell LTP-Kreise ein (Schaltfläche "LTP"), stellen eventuelle Patchlis-
ten ("P") ein oder schalten das Netzwerk-Senden ein (Schaltfläche "Net Out"). 
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Auswahl Bedeutung 

NW-Univ Auswahl eines oder mehrerer (Multi Universe Mode) Universes, die gemergt wer-
den sollen 

Je nach "Multi Universe Merge" (siehe folgender Abschnitt) sehen Sie bei den Netz-
werk-Universes nur 1 Eingabezelle oder 15! 

DMX-In Auswahl eines DMX-In als Datenquelle. Es werden nur DMX-Anschlüsse angezeigt, 
die als DMX-In definiert sind. 

● DMX-In ist als Datenquelle ausgewählt 

○ DMX-In ist nicht ausgewählt 

Profibus Off:  Profibus ist nicht als Datenquelle zum Mergen ausgewählt 

On:  Profibus ist als Datenquelle zum Mergen ausgewählt 

Cue mem Die Stimmungsspeicher können nur in bestimmten "Control modi" am Gerät als Da-
tenquelle ausgewählt werden. 

Patch Anzeige/Editieren des Patch unter der Spalte "P" bzw. der DMX-IN-LED "Patch" 

Wenn der Patch nicht anwählbar bzw. "-" ist, so ist er global ausgeschaltet (Config-
>DMX->Options). 

  

 

Sollen die Daten über Profibus verarbeitet werden, muss dies an der SPS parame-
triert werden. 

 

 

 

Die Schaltfläche "LTP" ermöglicht es, mit einem Kreis-Editor bestimmte oder alle Kreise dieses 
Ports LTP zu mergen, anstelle von HTP (Erläuterung siehe Anhang). 

 

Die Schaltfläche "Net Out" stellt das Aussenden über Netzwerk ein. 

 

Routing->Options 

Hinter der Seite "Options" verbirgt sich das "Multi Universe Merging". 

Dieses einzigartige Feature ermöglicht, dass jeder Port nicht nur 1, sondern bis zu 15 verschiedene 
Universes mergen kann! Das kostet erhebliche Rechenzeit, so dass die Anzahl der verarbeiteten 
Universes etwas CPU-abhängig ist. 

 

Auch ist dies netzwerkprotokoll-abhängig und prinzipbedingt bei Art-Net und Show-Net nicht mög-
lich! 
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Einstellen des Zielmediums Ethernet/DMX/Profibus 

Zielmedium Ethernet 

In der Routing-Statuszeile des jeweiligen Ports befindet sich der Button „Net Out“. Hier kann ein-
gestellt werden, ob der Puffer ins Ethernet gesendet werden soll. Die weiteren notwendigen Ein-
stellungen sind Universe (und ggf. Subnet) und Priorität. 

 

 

Auswahl Bedeutung 

1…8 Auswahl des Mergepuffers, dessen Inhalt ins Ethernet gesendet werden soll. 

Off Der Inhalt des Mergepuffers wird nicht ins Ethernet gesendet. Der Inhalt steht aber 
anderen Medien zur Verfügung. 

DMX-Out Der Inhalt des Mergepuffers/Ports wird ins Ethernet gesendet. 

 

 

Sollte der Port als DMX-OUT definiert sein, wird der Inhalt des Merge-
puffers parallel auch über den DMX-Anschluss gesendet. 

 

DMX-In Ist der DMX-Anschluss als DMX-IN definiert, werden die eingehenden DMX-Signale 
direkt ohne den Inhalt des Mergepuffers ins Ethernet gesendet. 

 

 

Sollen die Daten des DMX-IN mitsamt dem Mergepuffer gesendet wer-
den, muss der DMX-IN als Datenquelle im Merge eingetragen und in die-
sem Menü die Einstellung DMX-OUT gewählt werden. 

 

 

Werden die Daten des DMX-IN direkt ins Ethernet gesendet, kann der 
Inhalt des Mergepuffers für andere Zielmedien, z.B. Profibus, verwendet 
werden. 

 

Universe/ 
Subnet/Priorität 

Einstellen des Universe/Subnets/Priorität je nach Lichtprotokoll 

 

 

Zielmedium DMX 

Sollen die Daten im Mergepuffer über den DMX-Port gesendet werden, muss der DMX-Anschluss 
als DMX-OUT definiert werden. Die Daten im Mergepuffer liegen automatisch am DMX-Anschluss 
an. Das ausgehende DMX-Signal kann im Konfigurationsmenü DMX noch im Timing manipuliert 
werden. 

 

 

 
Die Daten am DMX-OUT können parallel auch über Ethernet gesendet werden. 
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Zielmedium Profibus 

Die Daten des Mergepuffers können bi-direktional mit dem Profibus gesendet werden. Die Einstel-
lung der Werte und Datenbereiche muss an der SPS vorgenommen werden, da das LSS Master-
Gate in diesem Bussystem nur als Slave eingebunden ist.  

 

 

 

Einstellen des DMX- und RDM-Protokolls – Config-DMX 

In diesem Menü werden die technischen Einstellungen für die DMX-Anschlüsse vorgenommen. Die 
Einstellungen können separat für jeden Anschluss vorgenommen werden. Beispielhaft ist hier der 
Port 1 dargestellt. 

 

 

 
 

 

Die Anzeige „Calculated Prot. time“ gibt die durchschnittliche Dauer eines DMX-Frames an. Sie 
wird errechnet aus Protocol length, Break, MAB, Protocol stretching und MBB. Bei den Defaultein-
stellungen wird das DMX-Signal mit nahezu maximaler Geschwindigkeit und RDM-erlaubten Wer-
ten für Break und MAB gesendet.  

 

 

 

Durch Ändern der Default-Werte können hier Werte erzeugt werden, die für die 
Stabilität des Netzwerkes und der Lichtsteuerung gefährliche Auswirkungen haben 
können! Die Default-Einstellungen sollten aus diesem Grund nicht geändert wer-
den! 
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Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

DMX DMX-
Port 

1..8 1…8 Auswahl des DMX-Ports zur Einstellung der indi-
viduellen DMX-Parameter 

Timeout DMX-IN: 1,2,…10 
DMX-OUT: HOLD, 1…10 

Einstellen des Timeouts für 
DMX-IN: wenn kein DMX-Empfang 
DMX-OUT: wann Senderabschaltung, wenn alle 
Mergequellen aus sind (oder HOLD) 

Protocol length 2…512 nur OUT: Einstellung der Protokolllänge 
Break 90…200...42000 µs nur OUT: Einstellung der Break-Länge 
Mark after 
break 

10, 20…42000µs nur OUT: Einstellung der Länge des Mark-after-
Break. 

Mark before 
break 

0…42000µs nur OUT: Einstellung der Länge des Mark-before-
Break. 

Protocol stret-
ching 

1…44 nur OUT: Dehnung des DMX-Frames, Protokolle 
pro Sekunde 

Calculated 
prot. Time 

 
nur OUT: Nur Anzeige! Kalkulierte Länge des 
DMX-Frames aufgrund der Einstellungen 

RDM Off, On Einschaltung RDM für gewählten Port 
RDM Discovery Off, On nur OUT: RDM-Discovery aktiv 
Filter Off, On Freigabe des DMX-Filters und des dazugehörigen 

Editors für gewählten Port. 

Filter 

 
Aufruf des Filter-Editors für den gewählten Port 
zum Editieren der Filtertabelle 

Def 
 

Laden der Default-Werte der DMX-Timings die-
ses Ports. 
Zum Aktivieren müssen Einstellungen gespei-
chert werden. 

Options RDM-Intervall 1...10…9999 Einstellung des Intervalls in Sekunden für inkre-
mentelle Discovery. 

Incremental 
discovery 

Off, On Einschalten der inkrementellen Discovery.  

Background 
discovery 

Off, On Einschalten des Background Modus für inkre-
mentelle Discovery. 

Patch enable  Globale Freigabe des Patch für alle Quellen und 
Ports 

Static filter  Globale Freigabe des DMX-Filters für alle Ports. 
RDM Discover  Löst die volle RDM-Discovery neu aus. 

 

Einstellen des DMX-Protokolls – DMX-Port 

Aufbau des DMX-Protokolls 

 

Die Zeichnung zeigt den 
Aufbau eines DMX-Frames. 
Einzelne Teile eines Frames 
können manipuliert werden, 
um den Frame zu strecken 
oder zu stauchen, so dass 
die Geschwindigkeit der 
Übertragung verändert wird.  
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Einstellungsmöglichkeiten 
 

Einstellung Bedeutung 

1..8 Auswahl der DMX- Anschlüsse. Ob der Anschluss als Eingang (In) oder Ausgang 
(Out) definiert ist, wird hinter der Port-Nummer angezeigt. 

Timeout Port = In: Empfangs-Timeout bei Empfangs-Ausfall. Nach Ablauf der ein-
gestellten Zeit, wird der DMX-IN als Merge-Quelle abgeschal-
tet. 

Port = Out: Sende-Timeout, wenn der Mergepuffer/DMX-OUT keine Da-
ten mehr erhält 
 

 Hold: Der letzte Wert wird unverändert weitergesendet. 
 1…10: Nach Ablauf der eingestellten Zeit wird der Merge-

puffer/DMX-OUT abgeschaltet. 
 

Protocol 
length 

(nur wenn der Port als Out definiert ist) 

2…512: Anzahl der Bytes bzw. Kreise im DMX-Protokoll 

Vorsicht: viele Empfänger erwarten hier immer 512! 

Break (nur wenn der Port als Out definiert ist) 
Stellt die Länge des Break in µs ein. 
Wenn die Einstellung nur in der A-Norm DMX512A erlaubt ist, wird ein A! an-
gezeigt. Ist die Einstellung für die RDM-Norm ANSI E1.20 verboten, wird R! an-
gezeigt. 

Mark after 
break 

(nur wenn der Port als Out definiert ist) 
Stellt die Länge des Mark after Break in µs ein. 
Wenn die Einstellung nur der Norm DMX512-A entspricht, wird ein A! ange-
zeigt. Ist die Einstellung für die RDM-Norm ANSI E1.20 verboten, wird R! ange-
zeigt. 

Mark before 
break 

(nur wenn der Port als Out definiert ist) 
Stellt die Länge des Mark bevor Break in µs ein. 

Protocol stret-
ching 

(nur wenn der Port als Out definiert ist) 
Einstellung der Protokolle pro Sekunde. Das DMX-Protokoll wird zwischen den 
einzelnen Slots gedehnt. 

Calculated 
prot. Time 

Hier wird die kalkulierte Länge eines DMX-Frames angezeigt, die aus den obi-
gen Einstellungen errechnet wird. 

RDM On: Schaltet RDM für den gewählten Anschluss ein. 
Off: Schaltet RDM für den gewählten Anschluss aus. 
Das LSS MasterGate tritt an definierten Out-Anschlüssen als RDM-
Controller und an definierten In-Anschlüssen als Responder auf. 

 

Discovery 

(nur sichtbar, 
wenn RDM ak-
tiv und min-
destens ein 
Anschluss als 
Out definiert 
ist) 

On: Aktiviert die RDM-Discovery Funktion für den ausgewählten An-
schluss. 

Off: Deaktiviert die RDM-Discovery Funktion für den ausgewählten An-
schluss. 

 

 

Eine neu angestoßene volle RDM-Discovery verursacht 
kurzzeitig hohen Datentraffic im Universe und kann die DMX-
Steuerung beeinträchtigen! 
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Laden der DMX-und RDM-Default-Werte – DMX→Def 

„Def“ lädt die Default-Timing-Werte für den gewählten Port. Es werden keine Default-Werte in an-
deren Menüs geladen und es findet kein Reset des Gerätes statt. 

 

Es wird empfohlen, mit den Defaultwerten für das DMX-Timing zu arbeiten. Diese haben sich über 
Jahrzehnte als sehr kompatibel erwiesen. Bei ganz alten, problematischen Endgeräten kann es 
sinnvoll sein, statt Break und MAB eher das Protocol stretching auf 43...33 zu stellen! 

 

 

Einstellen der RDM-Funktion – DMX→Options 

In diesem Untermenü werden die globalen, für alle Universen geltenden RDM-Einstellungen fest-
gelegt. 

Einstellung Bedeutung 

RDM-Intervall Stellt die Intervallzeiten der inkrementellen Discovery in Sekunden ein. 

Wertebereich: 1…65535 

Incremental 
discovery 

Mit dieser Funktion ist RDM-Discovery immer aktiv! Es werden immer Daten 
gesammelt und Identifizierungsanfragen für neue Geräte in die Universen ge-
sendet.  

On: Incremental discovery ist immer aktiv. 

Off: Incremental discovery ist nicht aktiv. 

Background 
discovery 

Mit dieser Funktion arbeitet die inkrementelle Discovery verlangsamt im Hin-
tergrund. Dadurch wird das DMX-Signal weniger gestört. Allerdings kann es 
sein, dass sich die Intervallzeit weit über oben eingestellte hinaus verlängert! 

On: Background discovery ist aktiv. 

Off: Background discovery ist nicht aktiv. 

Patch enable Globale Freigabe des Patch für alle Quellen und Ports. 

On: Patch freigegeben 

Off: Patch nicht freigegeben 

Static filter Globale Freigabe des DMX-Filters für alle Ports. 

On: DMX-Filter freigegeben 

Off: DMX-Filter nicht freigegeben 

RDM Discover Löst die volle RDM-Discovery neu aus. 

 

 

RDM-Discovery verursacht sehr hohen Datentraffic in den Universen! Das kann die 
DMX-Steuerung beeinträchtigen oder sogar unmöglich machen! 

Stellen Sie insbesondere die inkrementelle Discovery nicht zu schnell ein! In den 
meisten Anwendungsfällen außer der Inbetriebnahme vieler Endgeräte genügen 
5...30 Minuten, also 300...1800s, vollkommen! 
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Einstellen der Netzwerkparameter – Ethernet 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

Ethernet Receive protocol Default, Art-Net, 
AVAB/IPX, AVAB/UDP, 
ShowNet, sACN 

Einstellung des Empfangsprotokolls. 

Receive timeout (s) 0,1 ... 999,9 s Einstellung des Timeouts beim Datenempfang. 

Transmit protocol Default, Art-Net, 
AVAB/IPX, AVAB/UDP, 
ShowNet, sACN 

Einstellung des Sendeprotokolls. 
Default = Empfangsprotokoll  

Transmit Rate 20ms, 25ms, 40ms, 
50ms, 0.1s, 0.2s, 0.5s, 
1s, 2s, 3s, 4s 

Einstellung der Mindestsenderate, wenn sich die 
Sende-Werte nicht ändern. 

IP mode Auswahl 
 

11 verschiedene Modi auswählbar 

IP2 Art-
Net 

Auswahl Off, 2er, 10er Zweiter IP-Alias einstellbar, falls für Art-Net be-
nötigt 

IP 
address 

Einstellung  Entsprechend des IP-Mode voreingestellte IP-
Adresse, deren letzte Oktetts teilweise noch edi-
tiert werden können 

Subnet 
mask 

Einstellung  Entsprechend des IP-Mode voreingestellte Sub-
net-Maske, deren letzte Oktetts teilweise noch 
editiert werden können 

Gate-
way 

Einstellung  Gateway-Adresse, diese muss im Subnet der ein-
gestellten IP-Adresse liegen 

DNS ser-
ver 

Einstellung  DNS-Server-Adresse 

Services Telnet OFF, On Telnet-Server 

FTP OFF, On FTP-Server 

mDNS OFF, On Multicast DNS 

RDM over Eth OFF, On RDM over Ethernet 

Remote Proto-
col 

OFF, DigiPlus, Nexus Einstellung des Remote-Protokolls für spezielle 
Anwendungen. 
Auswahl Off, DigiPlus oder Nexus 
 

Domain local Domainname. Default ist local 

Hostname Einstellung Hostname des Gerätes im DNS-Netzwerk. Default 
ist MasterGate2-xxxxxx, wobei xxxxxx für die 
letzten drei Oktetts der MAC-Adresse stehen 

Options Art-Net III net-
work address 

0…127 Einstellung der ArtNet III Network-Adresse. 
Wertebereich 0...127 

Art-Net send 
full broadcast 

Off, On ArtNet wird als Broadcast gesendet. Nur für äl-
tere ADB-Anlagen. 

Art-Net 4 (reply 
per port) 

On, Off Art-Net 4 

Art-Net/sACN 
transmit length 

2...512 Universe-Sendelänge über Netzwerk 

sACN transmit 
discover Prot. 

Off, On Aussenden des sACN Discover Protokolls 

sACN transmit 
Draft 

Off, On Aktiviert sACN Draft-Modus. 

sACN detect 
Channel priori-
ties 

Off, On Auswertung sACN-Kreisprioritäten 
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IPv4ll 
(Zeroconf) if 
DHCP fail 

Off, On Verhalten bei DHCP-Ausfall 

UDP Checksum 
calculation 
on/check  

Off, On 
 

Ethernet media Autoneg., 
10half,  
10full,  
100half,  
100full 

Einstellung der Ethernet-Übertragungsgeschwin-
digkeit. Auswahl zwischen Autonegotiation, 10 
Halbduplex, 10 Fullduplex, 100 Halbduplex und 
100 Fullduplex. Bei Änderung dieses Parameters 
wird das Gerät einen Neustart vollziehen  

Remote time-
out 

1…5…99 Nur wenn Remote protocol On: 
Timeout für Remote Protokoll 

Remote-IP Einstellung Nur wenn Remote protocol On: 
IP-Adresse des Remote Teilnehmers 

 
 

Einstellungen Bedeutung 

Receive 

Protocol 

Einstellung des Empfangs-Netzwerkprotokolls 

Wird bei Wechsel des Protokolls automatisch auf dessen Defaulteinstellung an-
gepasst! 

Receive time-
out 

Einstellung des Timeouts beim Datenempfang 

 

Transmit Pro-
tocol 

Einstellung des Sende-Netzwerkprotokolls  

Default:  Sendeprotokoll entspricht dem Empfangsprotokoll  

Transmit rate 
min. 

Einstellung der Mindestsenderate, wenn sich die Sende-Werte nicht ändern. 

Einstellbar zwischen 20ms und 4s. Default für sACN ist 0,5s 

Wird bei Wechsel des Protokolls automatisch auf dessen Defaulteinstellung an-
gepasst! 

IP mode Bestimmt die Art der IP-Adressvergabe, von ganz frei einstellbar, über be-
stimmte vorgegebene Bereiche/private Adressen bis hin zur vollautomatischen 
Vergabe. 

Folgende Einstellungen sind möglich: 

Static, manual Manuell eingestellte IP-Adresse 

2.0.0.0/8 Art-Net 2 Oktet 2...4 automatisch nach Art-Net-
Norm 10.0.0.0/8 Art-Net 10 

10.0.0.0/8 Priv. RFC 1918, Oktet 2...4 frei einstellbar 

172.16.0.0/12 Priv. 
RFC 1918, Oktet 3,4 frei einstellbar 

192.168.0.0/16 Priv. 

192.0.2.0/24 TEST1 

RFC 6890, Oktet 4 frei einstellbar 198.151.100.0/24 TEST2 

203.0.113.0/24 TEST3 

DHCP Dynamic Host Configuration Protocol 

IPv4LL / ZeroConf Link local address, 169.254.0.0/16 
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IP2 Art-Net Hiermit ist eine zweite Alias-IP-Adresse einstellbar, falls diese für Art-Net benö-
tigt wird und die eigentliche-IP-Adresse in einem anderen Netzwerk ist. 

Folgende Einstellungen sind möglich: 

Off:   2. IP-Adresse aus 

2.255.255.255/8: Art-Net 2, Oktet 2...4 automatisch nach Art-Net-Norm 

10.255.255.255/8: Art-Net 2, Oktet 2...4 automatisch nach Art-Net-Norm 

IP address  

Entsprechend des IP mode können /müssen diese Adressen noch angepasst 
werden 

Subnet mask 

Gateway 

DNS server Eingabe einer DNS-Server-Adresse, optional. 

Services Diese Einstellungen sind über einen Button im Menü Ethernet erreichbar. Ein-
gestellt werden können die Netzwerkdienste  

Telnet   RFC 854 

FTP   RFC 959 

mDNS   RFC 6762 

RDM over Ethernet  Off, Art-Net-RDM, RDM-Net nach ANSI E1.33 

Remote Protokoll  Nebenpultkopplung für DigiPlus oder Nexus Stagetec 

   Ist das Remote protocol eingeschaltet, so ist unter  

   Ethernet->Options die Remote-IP-Adresse und der 

   Timeout einstellbar.  

Domainname   Eingabe des Domain Name 

Hostname  Eingabe des MasterGate Hostname 

Options Weitere Netzwerk-Optionen: 

Art-Net III network address (siehe Art-Net Norm) 

 0: Art-Net II kompatibel 

 1..127: ab Art-Net III 

Art-Net send full broadcast (Default Off) 

 ArtNet wird als Broadcast gesendet. Nur für ältere ADB-Anlagen. 

Art-Net 4 (reply per port), (Default On) 

 MasterGate verhält sich Art-Net 4 kompatibel. Sollte eingeschaltet sein. 

Art-Net/sACN transmit length (Default 512) 

 Anzahl der DMX-Werte, die vom MasterGate ins Netzwerk als Universe 
 gesendet werden. Nur sACN und Art-Net unterstützen im Protokoll die 
 Angabe der Sendebytes. 

sACN transmit discover prot. (Default Off) 

 sACN Discover Protokolle aussenden, nur für Lichtanlagen, die dies be-
 nötigen. 

sACN transmit draft (Default Off) 

 sACN Draft Protokoll (ist veraltet). 

sACN detect channel priorities (Default On) 

 Die Einzelkreis-Prioritäten auswerten, falls die Lichtanlage diese mittels 
 der sACN-Erweiterung von ETC aussendet (sog. DD-Protokolle). 
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 Bei Off werden nur Paketprioritäten berücksichtigt. Abschalten kann bei 
 fehlerhafter Lichtanlagen-Software manchmal notwendig sein. 

IPv4LL (ZeroConf) if DHCP fail (Default On) 

 Ist IP mode DHCP eingestellt und kein DHCP-Server im Netzwerk zu fin- 
 den, so erfolgt nach dem standardgemäßen DHCP-Timeout ein Fallback 
 auf eine nach RFC3927 automatisch erzeugte LinkLokal-IP-Adresse (" 

 ZeroConf") 169.254.0.0/16. 

UDP checksum calculation/check (Default On) 

 UDP-Prüfsummen berechnen, für Empfang und Senden 

Ethernet media: 

 Autoneg (Default) Auto-Negotiation, automatische Link-Geschwindigkeit 

 10half…100full 10 bzw. 100MBit, halb- oder vollduplex 

  

 

Das Ändern von Ethernet media führt zu einem Neustart 

 

  

 

Bitte beachten Sie, dass Änderungen der folgenden Netzwerk-Parameter erst wirksam 
werden, nachdem Sie das Menüsystem verlassen haben und sich das MasterGate in ei-
nem der Info-Bildschirme befindet! 

 
Receive protocol 
Transmit protocol 
IP Mode Auswahl 
IP2 Art-Net Auswahl 
IP address Einstellung 
Subnet mask Einstellung 
Gateway Einstellung 
DNS server Einstellung 
Services: Telnet, FTP, mDNS, RDM over Eth, Remote protocol, Domain, Hostname 
 
Während des Netzwerk-Neustarts ist das Gerät einige Sekunden nicht remote erreichbar! 
 
Eingabe von Namen (Domainname, Hostname, Art-Net Short Name) mittels Encoder 
 
Nach Anwahl des Textfeldes und 1x Drücken kann man mit dem Encoder durch die Textpositionen 
scrollen (Cursor blinkt nicht). Ganz rechts erscheint ein √ Symbol. Fährt man mit dem Cursor auf 
dieses Symbol und drückt, ist die Eingabe beendet. 
Durch Drücken auf eine Textposition ist man in der Zeicheneingabe (Cursor blinkt) und kann durch 
Drehen das Zeichen ändern. Mit Drücken ist man zurück in der Positionsanwahl (Cursor blinkt 
nicht). 
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Einstellen des Profibus 

Profibus-DP ist ein Feldbussystem mit Master/Slave-Struktur. Das LSS MasterGate ist Profibus-
Slave. Die eigentliche Konfiguration und Parametrierung wird am Master, meist einer SPS, vorge-
nommen.  

 

 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

Profibus Slave Address 0…126 Einstellung der Profibus-Slaveadresse 

Ident MasterGate, ProfiGate Auswahl der Profibus-Ident-Nummer 

Sep. buffers Off, On Einstellung, ob eingehende DP-Daten auf alle 
oder einzelne Merge-Puffer angewendet wer-
den. 

Baudrate, Bus status Nur Anzeige 
 

Profibus->DMX/Eth  Ruft den Monitor für Datenausgang von Profibus 
ins DMX oder Ethernet auf. 

DMX/Eth->Profibus  Ruft den Monitor für Dateneingang von DMX 
oder Ethernet in den Profibus auf. 

Param  Anzeige der Profibus-Slave-Parametrierung 

 Config  Anzeige der Profibus-Slave-Konfiguration 

 

 

 

Einstellungen Bedeutung 

Slave Address Einstellung der Profibus-Slaveadresse des LSS MasterGate 

Ident Auswahl der Profibus-Identnummer 

(das MasterGate kann das transtechnik ProfiGate ersetzen) 

Sep. buffers Auswertung des Puffer-Felds in den Profibus-Parametrierdaten 

Off:  Puffernummer nicht auswerten, alle Profibuswerte in 1 Universe pa- 
 cken, dieses Universe ist nur 1x vorhanden und kann zu beliebigen Puf- 
 fern gemergt werden 

On:  Puffernummer auswerten; diese bestimmt, in welchem Puffer der Wert 
 landet, d.h. auf welchem Port oder von welchem er eingelesen wird. 

Dieser Wert muss mit der SPS abgestimmt werden!  

Die Merge-Einstellung unter Routing->Port->Profibus Off/On bestimmt, ob die 
Werte gemergt werden sollen! 

Param/Config Aufruf des Monitors für Profibus-Parametrierung und -Konfigurierung. 
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Configuration→Profibus→Param und Config  

Im Profibus-Monitor können alle Profibus-Bytes sowohl für Eingaben als auch für Ausgaben gra-
fisch als Balkenanzeige oder als %-Wert und Hex-Zahl beobachtet werden. Die Anzeige und Bedie-
nung ist identisch zum DMX- und Netzwerkmonitor (Ausnahme: es gibt keine Verify-Funktion) 

 

Im Monitor für Parametrierung/Konfigurierung können außerdem die Parametrier- und Konfigu-
rierprotokolle des Profibus-Masters dargestellt werden. Je nach aktueller Parametrierung und 
Konfigurierung werden nur die Bytes dargestellt, die den aktuellen I/O-Bereichen entsprechen 
(ohne Profibus-Master keine vorhanden). 

In der oberen Zeile werden Zusatzinfomationen wie Refreshrate und Bus-Interrupts angezeigt. 

 

 

Einstellung Bedeutung 

Page 

0…20 

Einstellung des Anzeigebereichs 

OK Eine Menüebene zurück. 

 

 

 

Im Profibus-Monitor ist die selbsttätige Rückkehr in die Betriebsanzeige außer Kraft 
gesetzt, um auch längere Beobachtungen zu ermöglichen. 
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Einstellen der Stimmungsspeicher – Cue mem 

Das LSS MasterGate hat 32 interne Speicherplätze (Register) für Lichtstimmungen, die sich über bis 
zu 8 Universes erstrecken und an allen maximal 8 Ports gleichzeitig ausgegeben werden können. 
Alle Register haben ein virtuelles Potentiometer, eine Ein- und Ausblendzeit, außerdem gibt es ein 
33. Summenregister und dessen Summenpotentiometer. 

Die Speicherplätze und virtuellen Potentiometer werden über Profibus, ArtNet, DMX und weitere 
Möglichkeiten angesteuert. Somit wird eine einfache Probenlichtanlage möglich. Gespeicherte 
Lichtstimmungen können auch beispielsweise über Digitale Nebenpulte ein- und ausgefahren wer-
den. Hierzu gibt es Abrufkommandos mit "virtuellen Abruftasten" sowie einzelne "virtuelle" 
Dimm-Tasten, womit man alle 32 Register beliebig mischen kann sowie das Summenpoti ansteu-
ern kann. 

 

Das LSS MasterGate 1 hatte in einer besonderen SL-Ausführung ein Tastenfeld zur kom-
fortablen Bedienung des Stimmungsspeichers. Dieses ist beim MasterGate 2 aus Platz-
gründen entfallen. Stattdessen ist nun eine RS-485 Schnittstelle an der Geräterückseite 

vorhanden, der LSS-Bus. Über diesen wird in einer der kommenden Firmware-Versionen die Steue-
rung des Stimmungsspeichers über Modbus und somit per handelsüblichen Home-Automation-
Geräten möglich sein. 

 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

Cue 
mem 

Register len 1…8 Maximale Größe der Stimmungsspeicher 
Zum Datenaustausch mit anderen Geräten, an-
sonsten Defaultwert 8, nicht ändern! 

Control mode Profibus, DMX-In 8, 
Art-Net, 6 In, 6+8 In so-
wie Sonderanwendun-
gen 

Einstellung des Mediums bzw. Gerätes, über das 
der Stimmungsspeicher gesteuert wird.  

Store Out(s)  Anzeige oder Eingabe: Merge-Puffer, von dem 
eingespeichert wird 

Merge to Out  Anzeige oder Eingabe: Puffer, zu denen der Stim-
mungsspeicher gemergt wird 

Toggle mode Off, On Anzeige oder Eingabe: Registerabruf-Modus: "1 
einblenden, alle ausblenden" oder "einzeln ein-
blenden/ausblenden im Wechsel" 

Art-Net send Off, On Anzeige oder Eingabe: Aussenden des Register-
abrufs per Art-Net zur Fernsteuerung anderer 
MasterGates 

Cue Time In, Out 0…30 Voreinstellung für gespeicherte Ein- und 
Ausblendzeit mit Abruftasten 

Dim Time In, Out 0…30 Voreinstellung für gespeicherte Ein- und 
Ausblendzeit mit Dimm-Tasten 

Dim mode tmo Off, 15s, 30s, 1m, 3m, 
5m, 10m 15m, 20m, 
30m, 45m, 1h, 2h, 3h, 
4h, 6h, 8h, 12h, 24h 

Zeit bis die Registeranzeige in die betriebsan-
zeige zurückkehrt 

View   Aufruf des Monitors für den Stimmungsspeicher 
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Einstellung Bedeutung 

Register 
Len 

Maximale Größe der Stimmungsspeicher 
Defaultwert: 8 

Zum Datenaustausch mit anderen Geräten, ansonsten nicht ändern! 

Control  

mode: 

Einstellung des Mediums bzw. Gerätes, über das der Stimmungsspeicher gesteuert 
wird.  
Defaultwert: Profibus 

Vom Control mode hängt die manuelle Einstellbarkeit der folgenden 6 Parameter 
ab! 

Store outs: Merge-Puffer/Port, von dem eingespeichert wird. 

1…8:  es wird nur 1 Universe im Register gespeichert (1 Universe) 

ALL:  es werden die 8 Mergepuffer parallel eingespeichert (8 Universes) 

Merge to 
out: 

Zeigt an, in welchen Mergepuffer ein Register gemergt wird. 

Die Einstellung erfolgt per Profibus oder unter Config→Routing→Port(x)→Cue-
Mem. 

Toggle  

mode: 

Steuert das Verhalten der virtuellen Abruftasten für die 32 Register: 

Off:  Register fährt ein, alle anderen aus (jeweils mit ihren Zeiten). 

On:  Register fährt ein, kann mit auf Tastendruck gestoppt werden und fährt bei 
 erneutem Tastendruck aus (jeweils mit seiner Ein- und Ausblendzeit). 

 Alle anderen Register tun nichts. 

Art-Net 
send: 

Das MasterGate kann den Stimmungsspeicher anderer MasterGate fernsteuern 
(siehe oben). 

Cue time: Voreinstellung der im Register gespeicherten Ein-/Ausblendzeiten in Sekunden für 
den Abruf mit den "virtuellen Abruftasten". 

Ist der Wert 0, wird hart ein- und ausgeblendet 

Dim time: Voreinstellung der im Register gespeicherten Ein-/Ausblendzeiten in Sekunden für 
den Abruf mit den "virtuellen Dimmtasten". 

Ist der Wert 0, wird hart ein- und ausgeblendet 

Dim mode 
tmo: 

Zeit bis die Registeranzeige in die Betriebsanzeige zurückkehrt 

Off: Register-Übersicht bleibt eingeblendet 
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Aufrufen des Speichermonitors – Cue mem → View 

Das LSS MasterGate liefert bei Betrieb des Stimmungsspeichers wichtige Rückmeldungen: 

 

• Nummer des zuletzt abgerufenen Speichers 

• Flags für laufende Prozesse wie Ein/Ausblenden und Dimmen, Änderungen durch Dimmtas-
ten 

• Zustand der 32 Potiwerte der Register (kann z.B. für Balkenanzeigen usw. verwendet wer-
den 

• Zustand des Summenpotis 

• Belegt-Zustand der 32 Register 

 

Neben der grafischen Darstellung der Rückmeldungen können diese auch prozentual oder als zeit-
licher Wert angezeigt werden. 

 

Anzeige Bedeutung 

□ Zeigt ob das Register Daten enthält, es muss mindestens ein einziger Stromkreis 
einen Wert >1 haben. 

L: Letzte abgerufene Stimmung 

Lev Anzeigemodus (Lev=Balkengrafik) 

% Anzeigenmodus (%=Prozentuale Darstellung) 

Time Anzeigenmodus (Time=Darstellung in Sekunde; obere Wert=Einblendzeit, untere 
Wert=Ausblendzeit, über Summenpoti=Dimm-Zeit für Dim Mode) 

Su Summenpoti 

Mode Schaltet zwischen grafischer und Zahlenanzeige um. 
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Betriebseinstellungen im Options-Menü 

 

Zustand und Aufbau des Gerätes – Hardware Info 

 

 

Options → Hardware Info  

Hier werden Informationen zur Rechner-Zentraleinheit (CPU), die Versionen von Hauptplatine und 
BIOS sowie die Größe des Flash-Speichers, der als Harddisk dient, angezeigt: 

 

 

Auswahl Bedeutung 

Counter Aufruf des Menüs zur Anzeige der Boot- und Fehlerzähler. 

I/O Proc Parameter des Sendeprozessors 

OK Eine Menüebene zurück. 

 

 

Options → Hardware Info → Counter  

Hier werden die internen Betriebsspannungen, Temperaturen sowie verschiedene Zählerstände 
angezeigt. Die Zähler können auf 0 gesetzt werden, um Ereignisse ab einem bestimmten Zeitpunkt 
zu zählen: 

 

  

Ebene 2 Ebene 3 Ebene 4 Einstellungsmög-
lichkeiten 

Bedeutung 

Hardware Info   Anzeige von CPU-Informationen 

 Counter  Wichtige Informationen über den Zustand der 
Hardware, CPU-Auslastung, Systemtemperatur, 
Betriebsspannungen, Bootcounter 

 I/O Proc  Debug-Informationen zum Sendeprozessor 
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Wert Bedeutung 

Date/Time Anzeige der aktuellen Systemzeit 

CPU usage CPU-Auslastung in % 

Voltages Vcc: Betriebsspannung des LSS MasterGate  

Bat: Spannung der internen Pufferbatterie  

 

 
Ist die Spannung unter 2,7V, ersetzen Sie die Batterie! 

 

Temperatur Temperatur des Boards und der CPU, dazu die Min und Max-Werte 

Runtime total Betriebsstundenzähler 

Boot counter Bootvorgänge 

Ok Eine Menüebene zurück. 

 

Options → Hardware Info → I/O Proc  

Es können Debug-Informationen zum Sendeprozessor ausgelesen werden.  

Nur Anzeige und ein Encoder-Test-Button. 

 

 

Informationen zur Geräte-Firmware – Software Info 

 

 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmög-
lichkeiten 

Bedeutung 

Software Info   Anzeige von Software-Daten inkl. Firmware-Ver-
sion 

 

 

Options → Software Info 

Hier werden Informationen zur Firmware-Version, Betriebssystem sowie Programmgröße und 
freiem Speicher angezeigt. Außerdem werden die über Art-Net programmierbaren langen und kur-
zen Gerätenamen angezeigt. Der Kurzname kann editiert werden (siehe Hinweis unter Config-
>Ethernet->Options). 
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Timeouts, Screensaver, Remote Programming – Display Options 

 
 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmög-
lichkeiten 

Bedeutung 

Display 
Options 

Menu timeout (w/o moni-
tors) 

Off, 15s, 30s, 1m, 
3m, 5m, 10m 15m, 
20m, 30m, 45m, 1h, 
2h, 3h, 4h, 6h, 8h, 
12h, 24h 

Timeout für Verlassen des Menüs bei Nichtein-
gabe und Rückkehr zur Betriebsanzeige. Gilt 
nicht für die Monitoring-Seiten. 

Cue memory page timeout Off, 15s, 30s, 1m, 
3m, 5m, 10m 15m, 
20m, 30m, 45m, 1h, 
2h, 3h, 4h, 6h, 8h, 
12h, 24h 

Für kommende Anwendungen 

Screensaver timeout Off, 15s, 30s, 1m, 
3m, 5m, 10m, 15m, 
20m, 30m, 45m, 1h, 
2h, 3h, 4h, 6h, 8h, 
12h, 24h 

Timeout für Backlight-Abschaltung des Displays. 
Außer für Vorführungen, Messen usw. sollte 
diese immer aktiviert werden, um das LED-
Backlight des Displays zu schonen. 

Screensaver LEDs On, Off Einstellung ob Front-LEDs mit dem Display abge-
schaltet werden 

Screensaver Events On, Off Einstellung, ob Display (und Betriebs-LEDs) durch 
Änderungen an den Anschlüssen "aufwachen" 
sollen 

Remote programming On, Off Schaltet den Zugriff von LSS ConfigStudio auf das 
LSS MasterGate frei 

Fan control Off, Silent, LoNoise, 
Normal, Cool, Full 
On 

Einstellungen für den Gehäuselüfter 

 
 

Options → Display Options  

 

Einstellung Bedeutung 

Menu timeout 
(w/o monitors) 

Timeout für Verlassen des Menüs bei Nichteingabe und Rückkehr zur Be-
triebsanzeige. 

Gilt nicht für die Monitoring-Seiten. 

Screensaver 
timeout 

Timeout für Backlight-Abschaltung des Displays 

Außer für Vorführungen, Messen usw. sollte der Screensaver immer aktiviert 
werden, um das Backlight des Displays zu schonen. 

Screensaver 
LEDs 

Einstellung ob Betriebs-LEDs mit dem Display abgeschaltet werden 

Off: Die Betriebs-LEDs werden mit abgeschaltet 

On: Die Betriebs-LEDs werden nicht mit abgeschaltet 

Screensaver 
events 

Einstellung, ob Display (und Betriebs-LEDs) durch Änderungen an den An-
schlüssen "aufwachen" sollen. 
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Off: Statusänderungen wirken sich nicht auf Bildschirmschoner aus 

On: Statusänderungen an DMX-In/Out oder Ethernet schalten den  
 Bildschirmschoner aus und zeigen die jeweilige Statusseite an 

Remote pro-
gramming 

Off: Das LSS MasterGate ist nicht remote programmierbar 

On: Das LSS MasterGate ist remote programmierbar 

Das ist die Grundlage für Programmierung mittels ConfigStudio (und vormals 
ConfigCore). Ist diese Funktion deaktiviert, kann das Gerät nicht über die Kon-
figurationssoftware eingestellt werden. 

Fan Control Nur von Bedeutung, falls ein Gehäuselüfter installiert ist. 
Off   Lüfter aus 
Silent   Lüfter ein ab 55°C, volle Drehzahl ab 75°C 
LoNoise  Lüfter ein ab 50°C, volle Drehzahl ab 70°C 
Normal  Lüfter ein ab 45°C, volle Drehzahl ab 65°C 
Cool   Lüfter ein ab 40°C, volle Drehzahl ab 60°C 
Full On  Lüfter volle Drehzahl 

 

 

 

Umfangreiche Logging-Möglichkeiten – Log 

 

 
Ebene 2 Ebene 3 Ebene 4 Einstellungsmög-

lichkeiten 
Bedeutung 

Log Log settings Minimum Priority Einstellung, der Mindestpriorität, mit der Log-
ging-Informationen versendet werden 

Source filtering On oder Off. Wenn Source filtering angeschalten 
wird, erscheint in der letzten Zeile ein Button 
„Sources“, über den die geeigneten Quellen aus-
gewählt werden können  

Targets Festlegen des Ziels für Logging-Informationen 

 
 

Options → Log 

Das LSS MasterGate 2 besitzt umfangreiche Log-Möglichkeiten. 

Einstellung Bedeutung 

Minimum priority Einstellung, der Mindestpriorität, mit der Logging-Informationen gespei-
chert/versendet werden. 
Log Format ist BSD Syslog nach RFC 5424. 
Log-Klasse  Bedeutung 
Emergency  Abstürze, kein Betrieb möglich. 
Alert   Meldungen, die den normalen Betrieb verhindern 
Critical  Kritische Warnungen 
Warning  Warnungen, Fehlermeldungen 
Notice   Wichtige Meldungen (z.B. Start/Stop von Diensten) 
Info   Alle Meldungen im Detail. 
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Debug   Alle Meldungen und Debugausgaben. Nur auf Anweisung  
  verwenden! 

Source filtering On oder Off. Wenn Source filtering angeschaltet wird, erscheint in der letz-
ten Zeile ein Button „Sources“, über den die geeigneten Quellen ausgewählt 
werden können. 

Targets Einstellung der Ziele für Logausgaben. 

Telnet: zum Loggen muss Telnet eingeschaltet und der Client verbunden 
 sein 

Serial:  serielle Schnittstelle, ist nur bei Sonderausführungen vorhanden 

File:  Logdatei im Flash-Speicher 

Syslog: BSD syslog auf Remote server 

Ist syslog aktiviert, so kann weiter unten die IP des syslog-Servers und der 
Port eingegeben werden. Der syslog-Server sollte im gleichen Netzwerk sein 
wie das MasterGate. Keinesfalls sollte eine Broadcastadresse verwendet 
werden! 

Screensaver 
events 

Einstellung, ob Display (und Betriebs-LEDs) durch Änderungen an den An-
schlüssen "aufwachen" sollen. 

Off:  Statusänderungen wirken sich nicht auf Bildschirmschoner aus 

On:  Statusänderungen an DMX-In/Out oder Ethernet schalten den  
 Bildschirmschoner aus und zeigen die jeweilige Statusseite an 

 

 

Es können momentan bis zu 999 Log-Dateien im Flash gespeichert werden, danach werden die äl-
testen überschrieben. Die Größe ist auf 512kByte begrenzt. Auslesen kann man die Logfiles mit 
TFTP, FTP oder mit ConfigStudio. 

 

 

Die Auswahl der obigen Parameter kann dazu führen, dass die Infrastruktur mit Log-
Meldungen geflutet wird. Es ist also immer eine sinnvolle Vorauswahl notwendig 

 

 

Zugriffsautorisierung – Security 

 

 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmög-
lichkeiten 

Bedeutung 

Security Pin   Festlegung einer Zugangs-Pin 

 

 

Options → Security 

Hier kann die Zugangs-Pin geändert oder abgeschaltet werden: 
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Die aktuelle Pin wird immer als „*****“ angezeigt, auch wenn sie kürzer als 5 Zeichen ist. Durch 
Drücken auf „Clear“ wird die Pin gelöscht (Anzeige „OFF“). Wenn dieser Zustand mit „Ok“ gespei-
chert wird, erfolgen keine Abfragen mehr. 

 

 

Auswahl Bedeutung 

***** Pineingabe, Wertebereich 0...30000, 0 = Off 

Clear Pin löschen. 

Ok Einstellungen speichern und eine Menüebene zurück. 

Cancel Abbruch und eine Menüebene zurück. 

 

 

Obwohl das System eine große Sicherheit bietet, kann eine absolute Sicherheit 
nicht gewährleistet werden! Treffen Sie geeignete Maßnahmen vor Ort, um einen 
nichtautorisierten Zugriff zu verhindern! 

 

 

 

Die Sicherheit Ihrer Daten – Backup & Restore 

 

 
Ebene 2 Ebene 3 Ebene 4 Einstellungsmög-

lichkeiten 
Bedeutung 

Backup 
& Res-
tore  

    Speichern und Laden von bis zu 100 eigenen Ge-
räteeinstellungen. Laden von Werkseinstellun-
gen. 

 

 

Options → Restore Settings  

Im LSS MasterGate können Wiederherstellungspunkte definiert werden. Dadurch können neben 
den Werkseinstellungen auch eigene Einstellungen gespeichert und zu einem späteren Zeitpunkt 
wieder geladen werden. Es können dabei bis zu 100 eigene Einstellungen gespeichert und frei 
wählbar geladen werden. 

 

 
Beachten Sie die angezeigten Warnungen! 

 

Ebene 2 Ebene 3 Einstellungsmöglichkeiten Bedeutung 

Restore 
Settings 

Load Profile No change 
DMX-Merger 2-in-6 
Network Node 8Out 
DMX-to-network 8In 

Geräteprofil laden 

Restore to Factory defaults 
...max 100 Usersettings 
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Einstellung Bedeutung 

Load Profile Laden eines vordefinierten Geräteprofils für das Routing 

Es werden nur die Routing-Parameter geändert, kein Netzwerk und keine Ti-
mings.  

Auswahl aus: 

No change    keine Änderung 

DMX-Merger 2-in-6   IN 7+8 mergen auf OUT 1...6, kein Netzwerk 

Network Node 8 Out   8xOUT, Universe 1...8 

DMX to Network 8 In   alle 8 Ports auf IN, Daten in Universe 1...8 senden 

Restore to Auswahl der Factory defaults (Werkseinstellungen gemäß letztem Firmware-
Update) oder einem Wiederherstellungspunkt nach Datum und Zeit 

User saved Nur Anzeige! Anzahl der gespeicherten Wiederherstellungspunkte 

Delete Löscht gespeicherte Wiederherstellungspunkte (diese müssen unter Restore to 
aufgerufen sein) 

Save Speichert Wiederherstellungspunkte mit Datum und Zeit 

 

 

 

Der Neustart des Gerätes – Reboot 

 

 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmög-
lichkeiten 

Bedeutung 

Reboot      Watchdog reset 

 

 

Options → Watchdog reset 

Unter diesem Menüpunkt wird die Haupt-CPU des MasterGate neu gestartet. 
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Konfiguration des MasterGate mit 
ConfigStudio 
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Konfigurationssoftware ConfigStudio 

Die Konfiguration der LSS MasterGate kann auch über die Konfigurationssoftware LSS ConfigStudio 
erfolgen. ConfigStudio steht als kostenlose Software auf der Homepage der LSS als Download zur 
Verfügung. Die Grundlagen der Software werden im Handbuch „ConfigStudio“ erläutert. Das 
Handbuch LSS MasterGate setzt voraus, dass diese Grundlagen beherrscht werden.  

 

Das LSS MasterGate wird ab der Firmware-Version 2 grundsätzlich nur noch mit der Software Con-
figStudio konfiguriert. Die ältere Version ConfigCore ist hierfür nicht mehr geeignet.  

ConfigStudio besitzt eine Hauptoberfläche, die Geräte in einer Liste anzeigt und grundlegende In-
formationen über diese enthält. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Geräteliste 

 

Geräte 

ConfigStudio sucht in allen erreichbaren Subnetzen nach Geräten, die auf ArtPoll-Netzwerkpakete 

antworten. Gefundene Geräte werden mit IP-Adresse und ArtNet-Kurzname dargestellt. 

 

Jeder Geräteeintrag erhält zusätzlich ein kreisförmiges Symbol, welches den Erreichbarkeitsstatus 

farblich darstellt. Die Farben haben folgende Bedeutung: 

 

1 

 

 

2 
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          Grün: Gerät ist aktiv und antwortet auf Statusabfragen 

 Gelb: Eine Antwort des Gerätes steht seit mindestens 4 Abfragen aus 

 Rot: Gerät ist inaktiv und hat auf die letzten Abfragen keine Reaktion gezeigt 

 Blau: Gerät wurde manuell hinzugefügt und existiert nicht im Netzwerk oder Phantommo-

dus (Fortlaufende Abfragen deaktiviert) ist angeschaltet 

Die meisten LSS-Geräteeinträge haben auch einen ausklappbaren Menüpunkt namens Portkonfi-

guration. 

 

 

Dynamische Fenster 

 

Im linken Bereich des Programmfensters finden Sie die wesentlichen Funktionen und Informatio-

nen für das momentan ausgewählte Gerät. Der Inhalt dieses Fensters bezieht sich immer auf das 

aktuell aktive Gerät in der Liste und verändert sich entsprechend. 

Im Normalzustand befinden sich hier Funktionstasten, Basisinfos und ein Beispielbild. 

Funktionstasten 

 

Die Funktionstasten bieten schnellen Zugriff auf wichtige Funktionen: 

• Ident: Sendet ein Kommando an das Gerät, worauf-

hin es sich akustisch und optisch bemerkbar macht. 

Muss zum Fortfahren nach Aktivierung wieder de-

aktiviert werden. 

• Default: Setzt das Gerät auf Werkseinstellungen zu-

rück. Hierbei gehen alle individuellen Einstellun-

gen verloren! 

• Reset: Startet das Gerät neu. 

• Eigenschaften: Öffnet das Konfigurationsfenster, mit dem alle veränderbaren Eigenschaf-

ten des Gerätes (bis auf DMX-Ports, siehe Portkonfiguration) angepasst werden können. 

• Cues: Bei aktiviertem FTP wird das Cue-Verwaltungsfenster geöffnet, mit dem gespei-

cherte Stimmungen gesichert und übertragen werden können. 

  

Basisinfos  

 

In Tabellenform werden hier die wichtigsten Infos des ausgewählten Gerätes dargestellt: 

• Langname: Der Art-Net Langname des Gerätes 

(enthält meist Gerätetyp, Firmwareversion, Revi-

sion und Firmwaredatum) 

• Kurzname: Der Art-Net Kurzname (Standardmä-

ßig Gerätetypbezeichnung) 
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• Standort: Der Standort des Gerätes (optional, wenn leer „unbestimmt“) 

• IP-Adresse: Aktuell aktive IPv4-Adresse des Gerätes 

• MAC-Adresse: MAC-Adresse des Gerätes im Hexadezimalformat 

• Firmware Version: Firmwareversionsnummer des Gerätes 

 

Texte mit diesem Symbol können an der jeweiligen Stelle bearbeitet, und für das entspre-
chende Gerät abgeändert werden. 

 

Portkonfiguration 

 

 

Wenn in der Geräteliste ein Geräteeintrag „aufgeklappt“ und Portkonfiguration ausgewählt 
wurde, verändert sich der Inhalt des dynamischen Fens-
ters. 

 
 

Die Ports des ausgewählten Gerätes werden grafisch dar-
gestellt und dienen als Schaltflächen, um den gewählten 
Port genauer zu konfigurieren.  

 

Alternativ können wichtige Porteigenschaften über die 
Elemente unterhalb der Darstellung angepasst werden: 

 

Enable aktiviert oder deaktiviert die physische oder netzwerkseitige Ausgabe von DMX-Daten. 

Universe enthält das Netzwerk-Universe, welches zum Senden/Empfangen von Lichtdaten ver-
wendet werden soll. 

RDM aktiviert/deaktiviert RDM-Funktionen am physischen DMX-Port. 

 

 

Die farbliche Umrandung des dargestellten Ports visualisiert dabei den aktuellen Status: 

 

grau:   Port ist inaktiv - sendet/empfängt keine DMX-Daten 

blau:   Zero/Backup - Port empfängt gerade keine DMX-Daten, sendet aber einen Grund-

  Wert von 0 

gelb:   Hold - Port empfängt gerade keine DMX-Daten, sendet aber weiterhin die zuletzt 

  erhaltenen Daten 

orange:  RDM - Port empfängt/sendet RDM-Pakete  

grün:   Port ist aktiv und sendet oder empfängt DMX-Daten 
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Wird einer der Ports angeklickt, erscheint das 
folgende Fenster. Es beinhaltet die Gesamt-
heit der Einstellungen des gewählten Ports. 

 

 

 

 

 

 

 

 

 

 

 

 

Übertragung von Einstellungen 

Einstellungen an den Geräten werden nicht direkt und in Echtzeit vorgenommen, sondern nach 
Bestätigung des Anwenders. Dies geschieht zum einen, um den Datenverkehr im Netzwerk gering 
zu halten und um Fehler bei den Einstellungen zu minimieren. Ein Hinweis unter der Geräteliste 
zeigt an, dass Änderungen lokal vorgenommen wurden und gesendet werden könnten  

 

 

 

 
 Um doppelte Änderungen zu vermeiden, ist eine Remote-Programmierung nur mög-

lich, wenn am MasterGate das lokale Menüsystem nicht geöffnet ist. Dann lehnt das 
MasterGate die Remote-Programmierung ab. Schließen Sie zuerst die lokale Bearbei-
tung ab, so dass sich das Gerät in einem der Info-Bildschirme befindet oder warten Sie 
auf den Menütimeout. 
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Das Eigenschaftsfenster 

Im Fenster Eigenschaften lassen sich alle Einstellungen, die nicht zu den physischen DMX-Ports ge-
hören, anpassen. Diese Einstellungen sind in den folgenden Abbildungen dargestellt. 

Für Support-Anfragen sind die Daten aus der Kategorie Informationen von besonderer Bedeutung. 
Anhand dieser Werte kann der Techniker Geräteeigenschaften erkennen, die für die Fehlersuche 
oder auch die Bestimmung der richtigen Firmware-Datei von Nutzen sind.  
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Die Kategorie Firmware-Update beinhaltet die 
Einstellungen, die für die Aktualisierung der Be-
triebssoftware des MasterGate 2 wichtig sind. 
Bitte updaten Sie diese Software nur nach Rück-
sprache  

 

Über einen Link (grüne Markierung) kann die ak-
tuelle Firmware von der LSS-Website herunterge-
laden werden. Hierfür ist ein Kennwort erforder-
lich. 

 

Durch Klicken auf den Button mit dem Fragezei-
chen (rote Markierung) erhalten Sie Informationen zu Fehlern, die während des Update-Prozesses 
aufgetreten sind. 

 

 

 

Cues  

In diesem Menü können Dateien für den Stimmungsspeicher hochgeladen werden.  

 

Über Verbinden/Trennen kann der interne FTP-
Server gesteuert werden. Dieser dient dazu, Re-
gisterdateien für den Stimmungsspeicher hoch-
zuladen, zu sichern und zu löschen. Insgesamt 
können 32 Register-Dateien (CUE*.BIN) im Gerät 
gespeichert werden. 
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Service 
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Netzsicherung wechseln 

Sicherungstyp:  Schmelzsicherung 1,6A T 

 

1. Trennen Sie das Gerät von der Spannungsversorgung und jeglichen anderen Verbindungen. 

2. Entriegeln Sie den Sicherungshalter oberhalb der Kaltgerätebuchse. 

3. Entnehmen Sie den Sicherungshalter. 

4. Entnehmen Sie die defekte Sicherung. 

5. Ersetzen Sie diese durch eine intakte Sicherung. 

6. Schieben Sie den Sicherungshalter wieder ein und vergewissern Sie sich, dass der Halter 
einrastet. 

 

Überbrücken Sie niemals eine Sicherung! 

Verwenden Sie nur den oben angegebenen Sicherungstyp! 

Stellen Sie sicher, dass der Sicherungshalter fest eingerastet ist! 

 

Kontaktaufnahme 

Falls Probleme beim Betrieb des LSS MasterGate auftreten, sollten die Beschreibungen und Hin-
weise in diesem Handbuch zur Fehleranalyse und Fehlerbehebung weiterhelfen. Sollte dies nicht 
der Fall und es werden weiterführende Hilfestellungen benötigt, wenden Sie sich an den LSS Ser-
vice. 

 

Bei der Kontaktaufnahme sollten folgende Informationen vorliegen: 

 

- Ort der Gesamtanlage und Position des LSS MasterGate in der Anlage (mit Angabe von Se-
riennummer/MAC-Adresse/IP-Adresse) 

- Ausführliche Fehlerbeschreibung 
- Ausführliche Beschreibung der bisher erfolgten Fehlersuche 
- Beschreibung zusammenhängender System- oder Geräteprobleme 

 

Kontaktadresse: 

LSS GmbH 

Licht-, Steuer- und Schaltanlagenbau GmbH 

Sonnenstraße 5 

D-04600 Altenburg 

Tel.: +49 3447 83 55 00 

mail@lss-lighting.de  
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Anhänge  
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Anhang A 

Besonderheiten der Netzwerkprotokolle 

Die Netzwerkeinstellungen (IP-Mode, IP-Adresse, Netzwerkmaske) des LSS MasterGate wirken sich 
bei den verschiedenen Lichtprotokollen unterschiedlich aus: 

 

Licht-Pro-
tokoll 

IP-Besonderheiten 

Art-Net IP-Mode, IP-Adresse und Netzmaske wirken sich direkt auf Art-Net aus. Aus Kompa-
tibilitätsgründen sollte immer der automatische IP-Mode „10.0.0.0/8 Art-Net 10“ 
verwendet werden. 

Obwohl in der Art-Net-Norm verschiedentlich als Default beschrieben, ist das 2er 
Art-Net Netzwerk überhaupt nicht zu empfehlen, denn es handelt sich um einen 
internet-routing fähigen IP-Bereich! Das schafft Routing-Probleme, wenn der PC, 
den man zum Konfigurieren der Geräte verwendet, außerdem im Internet ver-
wendet wird. Viele große Hoster, wie amazon, google usw. verwenden 2/8er Ad-
ressen. 

Dagegen ist das 10.0.0.0/8 Netzwerk ein privates, nicht geroutetes Netz. 

 

AVAB/IPX IP-Mode, IP-Adresse und Netzmaske wirken sich überhaupt nicht auf AVAB/IPX aus, 
da dieses ein Novell-Protokoll ist. 

Die IP-Einstellungen des MasterGate sind insofern egal. Empfohlener IP-Mode: 
„10.0.0.0/8 Art-Net 10“, oder andere private Bereiche. 

AVAB/UDP IP-Mode, IP-Adresse und Netzmaske wirken nicht auf AVAB/UDP aus, da AVAB/UDP 
mit Broadcasts arbeitet. 

Die IP-Einstellungen des MasterGate sind insofern egal. Empfohlener IP-Mode: 
„10.0.0.0/8 Art-Net 10“, oder andere private Bereiche. 

ShowNet IP-Mode, IP-Adresse und Netzmaske wirken sich auf ShowNet aus.  

Häufig wird 192.168.0.x/24 oder 192.168.1.x/24 verwendet. Die Netzwerkmaske 
sollte 255.255.255.0 sein.  

Um dies einstellen zu können, muss der IP-Mode „Static manual“ sein (oder DHCP, 
falls es einen entsprechenden DHCP-Server im Netz gibt). 

Um das MasterGate remote mittels ConfigStudio zu konfigurieren, muss der PC in 
diesem Netzwerk sein. 

sACN IP-Mode, IP-Adresse und Netzmaske wirken sich nicht auf ACN aus, da ACN ein Mul-
ticast-Protokoll mit der IP 239.255.x.y ist. Dieses wird unabhängig empfangen. 

Die IP-Einstellungen des MasterGate sind insofern egal. Empfohlener IP-Mode: 
„10.0.0.0/8 Art-Net 10“, oder andere private Bereiche. 
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Universes 

Das MasterGate kann mit jedem der 32 Netzwerk-Slots verschiedene Universes und ggf. Subnets 
empfangen. 

Die einstellbaren Parameter "Universe" und ggf. "Subnet" unterscheiden sich wie folgt: 

 

Protokoll Universe Subnet Besonderheiten 

Art-Net 0…15 entfallen Ab der Firmwareversion 2 sind Universe und Subnet bei Art-
Net zusammengefasst und verhalten sich wie bei sACN.  

Subnet:Universe 0:0 ist nicht mehr verwendbar, siehe 
nachfolgende Tabelle. 

 

Art-Net unterstützt keine Prioritäten. 

AVAB/IPX 1…12 0…9 Prioritäten von 0...200 unterstützt. 

AVAB/UDP 1…32 0…9 Prioritäten von 0...200 unterstützt. 

ShowNet 1…36 nicht vor-
handen 

Bei ShowNet gibt es eigentlich keine Universes, alle Dim-
merdaten werden in einem 18432 Kreise großen Feld darge-
stellt. In älteren Anlagen (5xx) konnte man dies auch konfi-
gurieren. 

Trotzdem hat sich in der Praxis die Einteilung in Vielfache 
von 512 durchgesetzt (wegen DMX). 

Das LSS MasterGate verhält sich beim Einstellen des Uni-
verse wie neuere Anlagen von Strand Lighting: hier stellt 
man nur noch Vielfache von 512 ein, „XDMX Nr.“ genannt. 
„Krumme“ Adressen sind nicht möglich. Die realen Kreis-
nummern von 1…18432 werden im Routing zusätzlich ange-
zeigt.  

sACN 1… 65279 nicht vor-
handen 

Prioritäten von 0...200 unterstützt. 

Prioritäten pro Kreis nach ETC sACN DD-Erweiterung wer-
den unterstützt 
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Die Art-Net Universe-Nummern wurden in der aktuellen Firmwareversion 2 nun an sACN ange-
passt, nach der folgenden Tabelle:  

 

Art-Net alt (Subnet:Universe) Art-Net neu (identisch zu sACN) 

0:0 Off (nicht verwendbar) 

0:1 1 

0:2 2 

… … 

0:15 15 

1:0 16 

… … 

1:15 31 

2:0 32 

… … 

2:15 47 

… … 

15:15 255 

 

Die für das ganze Gerät globale "Art-Net III network address" (0...127) wird *256 zu allen  

eingestellten Universen dazu addiert, so dass das höchste verwendbare Art-Net-Universe 32767 
ist. Im Menü "Config->Routing->Network Receive Universes" wird beim Einstellen die alte Schreib-
weise unten zusätzlich angezeigt. 

 

 

Wahl des Lichtprotokolls 

Bietet eine Anlage mehrere Lichtprotokolle zur Auswahl, so sollte vom Standpunkt der Netzwerk-
belastung die Rangfolge sein: 

1. sACN 

2. Art-Net 

3. ShowNet 

4. AVAB/UDP 

5. AVAB/IPX 
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Konfiguration für die verschiedenen Lichtprotokolle 

sACN 

Das Licht-Netzwerkprotokoll sACN ist das werksseitig voreingestellte Standardprotokoll. Beim La-
den der Default-Werte wird dieses Licht-Netzwerkprotokoll aktiviert und folgende Parameter ein-
gestellt:  

 

Empfangs-Netzwerkprotokoll: sACN 

Empfangstimeout:   2,5s 

Sende-Netzwerkprotokoll:  je nach Wunsch, Default=sACN 

Senderate:    0,5s 

 

Wird das MasterGate mit dem Netzwerkprotokoll sACN eingesetzt, so kann die Netzwerkbelastung 
für das Gerät und andere Netzwerkteilnehmer sehr effektiv gesenkt werden, wenn man manage-
mentbare Switche einsetzt, die "IGMP Snooping" beherrschen. 

Das MasterGate unterstützt IGMP v2. 

Derartige Switche erkennen, welche Universes die Geräte an jedem Switch-Port benötigen und 
schalten dann nur diese Universes zu den jeweiligen Geräten durch. 

 

Empfohlene Einstellungen für den Switch (je nach Modell): 

IGMP Snooping        Ein 

Router IGMP Version        v2 

Router Ports automatisch erlernen /Auto learn    Ein 

Abfrage letztes Mitglied / Last member query counter   Ein oder >= 2 

IGMP Abfragerstatus / IGMP Querier status    Ein 

IGMP Abfragerversion / IGMP Querier version    2 

Abfragerobustheit / Query robustness     2 

Abfrageintervall / Query interval      30 s 

Max. Abfrageantwortintervall / Query Max response interval  10 s 

Abfrageintervall letztes Mitglied / Last member query interval  1 s 

 

Art-Net 

Empfangs-Netzwerkprotokoll:  Art-Net 

Empfangstimeout:    10 s 

Sende-Netzwerkprotokoll:   je nach Wunsch, Default = Art-Net 

Senderate:     0,5 s 

  



LSS MasterGate 

 LSS 69 
 

 

ShowNet 

Empfangs-Netzwerkprotokoll:  ShowNet 

Empfangstimeout:    10 s 

Sende-Netzwerkprotokoll:   je nach Wunsch, Default = ShowNet 

Senderate:     0,5 s 

 

AVAB/IPX 

Empfangs-Netzwerkprotokoll:  AVAB/IPX 

Empfangstimeout:    2 s 

Sende-Netzwerkprotokoll:   je nach Wunsch, Default = AVAB/IPX 

Senderate:     0,5 s 

 

AVAB/UDP 

Empfangs-Netzwerkprotokoll:  AVAB/UDP 

Empfangstimeout:    2 s 

Sende-Netzwerkprotokoll:   je nach Wunsch, Default = AVAB/UDP 

Senderate:     0,5 s 
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Anhang B 

Technische Daten 

Allgemeine technische Daten 

 
Bauart: Fertiggerät 
Abmessungen BxHxT: 483 x 89 x 180 mm (19‘‘ 2HE) 
Gewicht: 2000 g 
Lieferumfang: Gerät, Kaltgeräteanschlusskabel 
  
EMV-Standards: EN 55022, class B, FCC part 15, level B 
RoHS Konform 
  
Spannungsversorgung: 100 – 240 V AC, 50/60 Hz 
Leistungsaufnahme: 15 W (typisch) 
Verlustleistung: 15 W 
  
Betriebstemperatur: 0 °C – 40 °C 

 

Schnittstellen 

 

DMX/RDM Wahlweise: 

• 8x RJ45, ESTA-Belegung 

• 8x 5polig XLR 
Ports können einzeln als Ein- oder Ausgang in der Konfiguration defi-
niert werden. Die Ports sind immer durch Optokoppler potentialge-
trennt. 

Ethernet: 1x RJ-45, IEEE-Belegung für 100BaseTx 
Profibus: 1x PROFIBUS-DP (EN 50170), Sub-D Buchse 9-polig 

Potentialtrennung durch Optokoppler 
LSS-Bus 1x Pfostenstecker mit Verriegelung 10-polig 

Projektabhängig optional ausgebaut 
RS-485, Potentialtrennung durch Optokoppler 
Protokoll: Modbus-RTU (in Vorbereitung) 
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Netzwerk 

DMX 

Allgemein 
DMX-Protokoll: DMX-512  
Standards: USITT 1990, DIN 56930-2, ANSI E1.11 
Baudrate: 250 kbps 
Ausgänge: einzeln potentialgetrennt 
 (ISOLATED nach ANSI E1.11 A1) 
Potentialtrennung:    Optokoppler 
Isolationsspannung:    1000V DC 

Isolationswiderstand:    109  
EMV: Filterbeschaltung nach Stand der Technik an allen Ein- 

und Ausgängen 
Terminierung: für Port 7/8 einschaltbar 
 

Empfang 

Startcode: =0 Lichtprotokoll (in Display ●) 

 <> kein Lichtprotokoll, RDM (in Display R) 
minimale Protokolllänge: Startcode + 2 Werte 
maximale Protokolllänge: Startcode + 512 Werte 
 (Werte über 512 gehen verloren) 

minimale Durchlaufverzögerung: 44 s 
maximale Durchlaufverzögerung: 22,5 ms 
Empfangstimeout: 1…10 s 
max. Abstand zwischen 2 Protokollen: 1…10 s 

Minimale erkannte Breaklänge: 48 s 
Maximal zulässige Breaklänge: 1,95 s 
 

Senden 
Startcode: 0 
Protokolllänge: Startcode + 512 Werte 
Minimale Protokollzeit: 22,4ms 
Breaklänge: 90µs…42ms (einstellbar) 
Mark After Break: 20µs…42ms (einstellbar) 
Mark Before Break: 0…42ms (einstellbar) 
Framerate (durch Dehnung des Prot.) 44…3 Protokolle/s (einstellbar) 
Zusätzliche Pause nach Startcode: 25µs, nur wenn Framerate <44 ist 
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Ethernet 

Allgemeines 
Schnittstelle: 10/100 BaseT (IEEE 802.3u, 802.3x) 
Geschwindigkeit: 10 MBit/s, 100MBit/s; Autonegotiation 
Duplex-Mode: halb, voll; Autonegotiation 
 Auto-MDI/MDIX 
Anzeige: Link-LED, Data-LED, Geschwindigkeit und Duplex-Mode 

werden im Display angezeigt 
Lichtprotokolle: Art-Net 4 (ArtisticLicence) 
 AVAB-IPX (AVAB, transtechnik, LDDE, …) 

 AVAB/UDP (transtechnik) 
 ShowNet (Strand Lighting) 

 sACN (ANSI E1.31) 
weitere Netzwerkprotokolle: RDM-Net ANSI E1.33 
 TFTP, FTP, Telnet, IGMPv2 
 TCP/IP  (FreeBSD network stack) 
 

Empfang 
Maximale Paketrate: >1000/s (bei 1 Lichtframe/Paket) 

Minimale Durchlaufverzögerung: 4 s 
Maximale Durchlaufverzögerung: 22,7 ms 
Max. Abstand zwischen 2 Protokollen: 1...999 s (Halten per DMX-Out einstellbar) 
 
 

Senden 
Senderate bei Wertänderung: maximal aller 20 ms 
Senderate ohne Wertänderung: 20 ms … 4 s (einstellbar) 
 

Profibus 

Unterstützte Baudraten: 9,6 kBit/s 12 MBit/s 
Stationsadresse: 0...126 
TSDRmin: 11 Bitzeiten 
PNO-Identnummer: 0A99h (MasterGate) 
GSD-Datei: verfügbar 
Diagnose: 1 Byte externe Diagnose (parametrierbar) 
Slave-Verhalten: modularer Slave, FREEZE, SYNC, AUTOBD. 
Länge Input-Bereich: max. 244 Byte 
Länge Output-Bereich: max. 244 Byte 
Summe der Input/Output-Bytes: max. 248 Byte 
Länge User-Parametrierung: max. 242 Byte (davon 235 für User) 
Anzahl Module: max. 16 
Byte pro Modul: 1...16, frei variabel, Byte-konsistent 
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Anschlussbelegung 

DMX-Anschlüsse 

5 Pin XLR 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 Data Ground 

2 Data - 

3 Data + 

4 Spare 

5 Spare  

 

PE kann über die Schirmung geführt werden 

 
 
 

RJ45 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 Data + 

2 Data - 

3 Spare 

4  

5  

6 Spare 

7 Data Ground 

8 Data Ground 

S Kabelschirm 
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Ethernet 

 

Pin Belegung 

1 Rx + 

2 Rx - 

3 Tx + 

4 V + 

5 V + 

6 Tx - 

7 V - 

8 V - 

S Kabelschirm 

 

 

Profibus 

Pinbelegung nach EN 50170 

Pin Belegung 

1  

2  

3 Data + 

4 RTS 

5 Ground 

6 +5V DC 

7  

8 Data - 

9  

 

Bestellnummer 

 

Modell Anschlüsse Bestellnummer 

LSS MasterGate RJ45 5501 

XLR 5511 

 

 


